
Talleres de autoformación
con programas informáticos
de análisis de redes sociales

Escola Universitària d’Infermeria i de Fisioteràpia «Gimbernat»

Escola d’Infermeria

Universitat Autònoma de Barcelona
Servei de Publicacions

Bellaterra, 2006

José Luis Molina (ed., UAB), Águeda Quiroga (UPF),
Joel Martí (UAB), Isidro Maya Jariego (US),

Ainhoa de Federico (UL1)



El autor agradece la ayuda y comentarios recibidos de:

Primera edición: octubre de 2006

Edición e impresión:
Servei de Publicacions

Universitat Autònoma de Barcelona
Edifici A. 08193 Bellaterra (Barcelona). Spain

sp@uab.es
http://publicacions.uab.es/

Impreso en España. Printed in Spain

Depósito legal: B. 46.471-2006
ISBN 84-490-2469-2



Índice

Talleres de autoformación con programas de análisis de redes sociales Materials 5

PRESENTACIÓN ........................................................................................................... 7

OPERACIONES BÁSICAS CON UCINET 6 ........................................................................ 9
Cómo introducir datos de relaciones (reticulares) ................................................ 9

Hoja de datos .................................................................................................... 9
Fichero de texto ................................................................................................ 11

Cómo convertir matrices de modo 2 en matrices de modo 1 ............................... 12
Completar filas o columnas.............................................................................. 12
Afiliaciones ...................................................................................................... 16

Cómo recodificar matrices.................................................................................... 19

EL ANÁLISIS DE REDES SOCIOCÉNTRICAS CON UCINET 6 Y NETDRAW ........................... 23
Introducción.......................................................................................................... 23
Descripción del ejercicio práctico ........................................................................ 24
Crear una matriz con Ucinet 6 .............................................................................. 26
Graficar una red con Netdraw .............................................................................. 29
Medidas de centralidad......................................................................................... 34

Grado nodal (degree)........................................................................................ 34
Grado de intermediación (betweenness) .......................................................... 37
Cercanía (closenness) ....................................................................................... 38
Redes dentro de redes: cliques ......................................................................... 40
Cliques.............................................................................................................. 40
N-clique, N-clan y K-plex ................................................................................ 46

EL ANÁLISIS DE REDES PERSONALES CON EGONET Y VISUALIZER ................................. 57
Notas sobre la instalación de Egonet .................................................................... 59
Módulo administrador (Egonet_QB).................................................................... 59

Questions about ego ......................................................................................... 60
Name genearator(s) .......................................................................................... 62
Questions about alters ...................................................................................... 63
Alter tie evaluation ........................................................................................... 64

Módulo cliente (Egonet) ....................................................................................... 65
La entrevista cualitativa con visualizer ................................................................ 68

Clusters o grupos de la red personal................................................................. 69
Grado de intermediación .................................................................................. 71
Composición: sexo, residencia y otras ............................................................. 73

Bibliografía ........................................................................................................... 76

EL ANÁLISIS DINÁMICO DE REDES CON SIENA-.............................................................. 77
El programa Siena: especificaciones del modelo ................................................. 78



aJ.L. Molina, A. Quiroga, J. Martí, I. Maya, A. de Federico6 Materials

Los primeros pasos con Siena: una sesión de trabajo con el programa.............. 79
Un ejemplo de aplicación del programa: la evolución de los intercambios 
en una lista de correo electrónico ....................................................................... 87
Bibliografía ......................................................................................................... 92
Apéndice I. Matrices utilizadas en el apartado los primeros pasos con Siena ... 93

EL ANÁLISIS DEL DISCURSO CON VISONE ................................................................... 95
El análisis reticular de textos .............................................................................. 95
El programa Visone ............................................................................................ 96

Panorámica general del programa .................................................................. 97
Cómo crear sociogramas y modificar el aspecto de nodos y vínculos........... 98

Creación de una red discursiva con Visone ........................................................ 99
Configuración general .................................................................................... 99
Dibujando nodos y vínculos ........................................................................... 100

Visualización y análisis de la red........................................................................ 100
Análisis básicos .............................................................................................. 100
Más posibilidades ........................................................................................... 104

Salidas y exportación de resultados.................................................................... 105
Bibliografía ........................................................................................................ 107



Presentación

Talleres de autoformación con programas de análisis de redes sociales Materials 7

Este manual intenta llenar un espacio hasta ahora cubierto de forma incompleta: el de
la autoformación en las diferentes aplicaciones del Análisis de redes sociales. Los tex-
tos teóricos disponibles en castellano empiezan a ser ya suficientes para disponer de una
introducción. Sin embargo, los talleres y las matrices de datos, tanto reticulares como atri-
butivos, están limitados prácticamente al web REDES (www.redes-sociales.net). 

Cada capítulo tiene la voluntad de ser un taller autosuficiente. Es por ello que en
ocasiones se pueden encontrar informaciones redundantes, pero siempre necesarias para
la realización de la práctica propuesta. 

Evidentemente este manual está pensado para Windows XP.





Operaciones básicas con Ucinet 6

José Luis Molina
Departament d’Antropologia Social i Cultural, UAB

Talleres de autoformación con programas de análisis de redes sociales Materials 9

La experiencia nos enseña que las dificultades para el análisis de redes sociales residen,
más que en cuestiones conceptuales o teóricas, en el aprendizaje de la mecánica de la trans-
formación de datos. Este capítulo está dedicado a la realización de unas pocas prácticas
iniciales que permitirán con toda seguridad moverse ágilmente por la variedad de posi-
bilidades analíticas del programa.

Cómo introducir datos de relaciones reticulares

Si bien a lo largo de este manual se encontrarán referencias a la manera de introducir datos
y construir matrices, presentamos a continuación una breve síntesis de las dos  formas
de introducir datos que pueden utilizarse en Ucinet 6. La primera es directamente en
una hoja de datos dentro del mismo programa; la segunda es mediante un fichero de
texto que creamos en otra aplicación y que luego importamos. Veamos cada una de ellas.

Hoja de datos

En la Ilustración 1 se presenta la pantalla inicial de Ucinet, en donde hemos resalto el
botón que permite activar la matriz de datos de Ucinet 6.

Esta matriz es útil para introducir pocos nodos de una forma rápida. Una vez clicado
el botón indicado, se desplegará otra pantalla (ver ilustración 2). Haremos una  pequeña
práctica para introducir una red de solamente 5 nodos. La relación que mediremos es si
las personas de la red han sido o no pareja sentimental estable. Dado que la relación «ser

Ilustración 1. La hoja de datos (spreadsheet) de Ucinet 6.
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pareja de» es simétrica (si A es pareja de B, B es pareja de A) lo primero que haremos
será seleccionar la opción de datos simétricos  para introducir fácilmente las etiquetas de
los nodos, antes de introducir los nombres de los integrantes de esta red. También indi-
caremos las dimensiones de la matriz: 5 filas y 5 columnas (Ilustración 2).

A continuación clicaremos en la celda seleccionada y comenzaremos a escribir los
nombres de los integrantes de la red: Penélope, Tom, Nikole, Melanie, Antonio. Una
vez escritos copiaremos estas etiquetas de las filas a las columnas con el comando:

Labels>Copy rows to columns

A continuación indicaremos con un «1» si son o han sido (o han dicho que han sido)
pareja estable. Como la matriz es simétrica sólo es necesario que indiquemos que Pené-
lope tiene un «1» con Tom, Tom un «1» con Nikole y Melanie un «1» con Antonio. Con
el comando

Fill>Missings with simmetric counterparts

rellenaremos los «1» que faltaban y con el comando 

Fill>Blanks w/0s

rellenaremos con «0» las celdas en blanco. Por último, solamente nos queda guardar la
matriz en un fichero (Ilustración 3).

File>Save As>prueba

Con esto ya tenemos generada una matriz de datos lista para ser analizada. El nom-
bre asignado por Ucinet 6 será 

prueba.##h

Ilustración 2. Hoja de datos de Ucinet 6.
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La hoja de datos de Ucinet 6 es compatible con la opción de copiar y pegar de Excel,
por lo que en ocasiones puede ser útil trabajar en esa hoja de cálculo, abrir la hoja de datos
de Ucinet y pegar la matriz seleccionada previamente. En este caso tenemos que tener
cuidado que no queden filas ni columnas en blanco, indicando en el apartado correspon-
diente el número exacto de ambas.

Fichero de texto

Cuando en el transcurso de una investigación se recogen datos relacionales, la lista de
nodos suele ser de decenas o centenas. Por tanto, es mucho más práctico recoger los
datos en otro formato, como por ejemplo

Penélope Tom 1
Tom Nikole 1
etc.

En lugar de introducir los datos directamente en la matriz, crearemos un fichero de
texto, que luego importaremos a Ucinet 6.

Ucinet 6 dispone de muchos tipos de formato para los ficheros de texto, pero el más
útil es el formato dl. Si quisiéramos incorporamos los datos de la red que hemos reali-
zado anteriormente en este formato deberíamos utilizar algún procesador de texto, y
escribir lo siguiente:

dl n = 5 format = el1

labels embedded

data:
Penélope Tom 1

Tom Penélope 1

Ilustración 3. Guardar la matriz generada en la hoja de datos.



Tom Nikole 1

Nikole Tom 1

Melanie Antonio 1

Antonio Melanie 1

De esta forma se indica a Ucinet 6 cada una de las relaciones. Si copiamos estas ins-
trucciones en un fichero de texto y lo guardamos como prueba2.txt podremos impor-
tarlo a Ucinet 6 de la siguiente forma:

Data>Import>DL>prueba2.txt

El resultado es el mismo que hemos obtenido con la hoja de datos. Ucinet crea un
fichero llamado

Prueba2.##h

Cómo convertir matrices de modo 2 en matrices de modo 1

Completar filas o columnas

A menudo nos encontramos con matrices de modo 2 que tienen que ser convertidas en
matrices de modo 1 para permitir algunos análisis. Las matrices de modo 2 resultan, por
ejemplo, cuando los respondientes citan nombres libremente, sin escogerlos de una lista.
Así tenemos en las filas los respondientes y en las columnas los nominados, que no sue-
len coincidir.1

Vamos a suponer que tenemos una encuesta por barrios a jóvenes barceloneses sobre
dónde van a divertirse por la noche. Tendríamos una matriz del tipo los del barrio A van
al barrio B. No todos los barrios reciben jóvenes, por lo que la lista de barrios de las
filas no coincide con la lista de barrios de las columnas. También puede ser que se que-
den en el barrio, por lo que nos interesan las relaciones reflexivas. 

Así tenemos un matriz de 10 barrios en las filas (los barrios de origen de los jóve-
nes) y de 24 barrios y otras poblaciones (los destinos) en las columnas. Los números
indican el número de jóvenes que se desplazan de un barrio a otro (Tabla 1).

1. En las matrices de modo 1, contamos con los mismos nodos en las columnas y en las filas, mientras que en las de modo
2 los actores de filas y columnas no son exactamente los mismos.
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El fichero de datos es el siguiente:

DL

NR=10, NC=24

FORMAT = FULLMATRIX DIAGONAL PRESENT

ROW LABELS:

«A»

«B»

«C»

«D»

«E»

«F»

«G»

«H»

«I»

«J»

ROW LABELS EMBEDDED

COLUMN LABELS:

«A»

«B»

«C»

«D»

«E»

«F»

«G»

«H»

«I»

«J»

A B C D E F G H I J K L M N Ñ O P Q R S T U V W

A 24 4 0 0 1 4 1 0 0 1 3 0 1 0 0 0 4 0 0 0 1 2 0 0

B 44 29 1 0 5 20 0 0 0 2 11 1 2 3 0 0 1 0 0 0 2 1 1 0

C 28 5 10 1 0 5 1 0 0 1 6 4 4 1 1 1 4 0 0 0 10 2 0 1

D 8 4 3 19 4 8 0 0 0 0 1 3 1 0 0 0 0 0 0 0 1 1 0 0

E 14 6 0 0 18 17 1 0 0 0 2 3 2 0 0 0 0 0 0 0 1 0 0 2

F 6 8 0 0 1 26 0 0 0 1 4 2 0 0 1 0 0 0 0 0 1 2 1 1

G 23 8 2 1 2 16 5 2 0 0 6 3 2 3 8 1 1 0 0 0 1 2 0 0

H 18 8 0 1 1 3 2 24 2 5 9 0 3 0 3 3 0 4 1 0 7 6 1 1

I 16 4 0 1 2 6 0 1 9 1 9 1 3 1 0 2 0 0 0 0 2 3 5 2

J 26 11 0 0 4 10 0 1 4 5 22 1 4 2 1 1 3 1 1 1 2 6 0 2

Tabla 1. Número de jóvenes que se trasladan para divertirse entre barrios de una ciudad 
y poblaciones anejas.
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«K»

«L»

«M»

«N»

«Ñ»

«O»

«P»

«Q»

«R»

«S»

«T»

«U»

«V»

«W»

COLUMN LABELS EMBEDDED

LEVEL LABELS:

«Page 1»

DATA:

«A» «B» «C» «D» «E» «F» «G» «H» «I» «J» «K» «L» «M» «N» «Ñ» «O» «P» «Q» «R» «S»

«T» «U» «V» «W»

«A» 24  4  0  0  1  4  1  0  0  1  3  0  1  0  0  0  4  0  0  0  1  2  0  0

«B» 44 29  1  0  5 20  0  0  0  2 11  1  2  3  0  0  1  0  0  0  2  1  1  0

«C» 28  5 10  1  0  5  1  0  0  1  6  4  4  1  1  1  4  0  0  0 10  2  0  1

«D»  8  4  3 19  4  8  0  0  0  0  1  3  1  0  0  0  0  0  0  0  1  1  0  0

«E» 14  6  0  0 18 17  1  0  0  0  2  3  2  0  0  0  0  0  0  0  1  0  0  2

«F»  6  8  0  0  1 26  0  0  0  1  4  2  0  0  1  0  0  0  0  0  1  2  1  1

«G» 23  8  2  1  2 16  5  2  0  0  6  3  2  3  8  1  1  0  0  0  1  2  0  0

«H» 18  8  0  1  1  3  2 24  2  5  9  0  3  0  3  3  0  4  1  0  7  6  1  1

«I» 16  4  0  1  2  6  0  1  9  1  9  1  3  1  0  2  0  0  0  0  2  3  5  2

«J» 26 11  0  0  4 10  0  1  4  5 22  1  4  2  1  1  3  1  1  1  2  6  0  2

Seleccionemos esos datos y copiémoslos en un fichero de texto con nombre
«jovenes.txt». Desde Ucinet 6 realizaremos la importación:

Data>Import>DL

Hay que tener cuidado que el nombre del fichero aparezca como el producto de la
exportación en el subdirectorio adecuado, sino no podremos localizarlo posteriormente. 

Abriremos la hoja de datos y cargaremos el fichero importado. A continuación cam-
biaremos el número de filas de la matriz a 24 y copiaremos las etiquetas de las colum-
nas en las filas. Por último, rellenaremos con ceros las celdas en blanco y guardaremos
una matriz de modo 1 con un nombre nuevo. El resultado debería el que muestra la ilus-
tración 4.
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En este momento podemos hacer un primer análisis, por ejemplo con Netdraw y
obtener una imagen de los desplazamientos de los jóvenes (Ilustración 5).

La escala de grises indica la proporción de jóvenes que salen de un barrio. El tamaño
del nodo indica la proporción de jóvenes que visitan un barrio y el grosor de la línea la
proporción de desplazamientos. Los nodos aislados indican que tienen muy pocos jóve-
nes con esta conducta Parece claro que el barrio A recibe la mayor parte de las visitas
nocturnas …

Para usar las potencialidades de Netdraw consultar el capítulo correspondiente.  

Ilustración 4. Matriz de modo 1 de 24 x 24 barrios o localidades.

Ilustración 5. Desplazamientos nocturnos de jóvenes.
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Afiliaciones

En ocasiones nos interesa conservar la matriz de modo 2 y hacer una análisis de filas por
filas o de columnas por columnas. El caso típico consiste en el análisis hecho por Davis
et. al. (1941) de un grupo de mujeres y los eventos sociales a los que asistieron. La matriz
de modo 2 del ejemplo es la siguiente:

DL

NR=18, NC=14

FORMAT = FULLMATRIX DIAGONAL PRESENT

ROW LABELS:

«EVELYN»

«LAURA»

«THERESA»

«BRENDA»

«CHARLOTTE»

«FRANCES»

«ELEANOR»

«PEARL»

«RUTH»

«VERNE»

«MYRNA»

«KATHERINE»

«SYLVIA»

«NORA»

«HELEN»

«DOROTHY»

«OLIVIA»

«FLORA»

ROW LABELS EMBEDDED

COLUMN LABELS:

«E1»

«E2»

«E3»

«E4»

«E5»

«E6»

«E7»

«E8»

«E9»

«E10»

«E11»

«E12»

«E13»

«E14»
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COLUMN LABELS EMBEDDED

DATA:

«E1» «E2» «E3» «E4» «E5» «E6» «E7» «E8» «E9» «E10» «E11» «E12» «E13» «E14»

«EVELYN» 1 1 1 1 1 1 0 1 1 0 0 0 0 0

«LAURA» 1 1 1 0 1 1 1 1 0 0 0 0 0 0

«THERESA» 0 1 1 1 1 1 1 1 1 0 0 0 0 0

«BRENDA» 1 0 1 1 1 1 1 1 0 0 0 0 0 0

«CHARLOTTE» 0 0 1 1 1 0 1 0 0 0 0 0 0 0

«FRANCES» 0 0 1 0 1 1 0 1 0 0 0 0 0 0

«ELEANOR» 0 0 0 0 1 1 1 1 0 0 0 0 0 0

«PEARL» 0 0 0 0 0 1 0 1 1 0 0 0 0 0

«RUTH» 0 0 0 0 1 0 1 1 1 0 0 0 0 0

«VERNE» 0 0 0 0 0 0 1 1 1 0 0 1 0 0

«MYRNA» 0 0 0 0 0 0 0 1 1 1 0 1 0 0

«KATHERINE» 0 0 0 0 0 0 0 1 1 1 0 1 1 1

«SYLVIA» 0 0 0 0 0 0 1 1 1 1 0 1 1 1

«NORA» 0 0 0 0 0 1 1 0 1 1 1 1 1 1

«HELEN» 0 0 0 0 0 0 1 1 0 1 1 1 0 0

«DOROTHY» 0 0 0 0 0 0 0 1 1 0 0 0 0 0

«OLIVIA» 0 0 0 0 0 0 0 0 1 0 1 0 0 0

«FLORA» 0 0 0 0 0 0 0 0 1 0 1 0 0 0

De nuevo seleccionamos los datos anteriores y los copiamos en un fichero de texto.
Este fichero lo importamos desde Ucinet, con el procedimiento que ya hemos mencio-
nado. Esta matriz de 18 mujeres en las filas y 14 eventos sociales en las columnas puede
ser analizada de forma que obtengamos una matriz de mujeres por mujeres (18 x 18) y
una matriz de eventos por eventos (14 x 14). En cada caso el análisis nos permitirá iden-
tificar grupos de mujeres o de eventos, mujeres o eventos centrales o periféricos, en fin,
obtener medidas estructurales sobre las relaciones.

Para ello seleccionamos en Ucinet 6

Data>Affiliations

En la ventana de diálogo que aparece en la Ilustración 6, seleccionamos el fichero
Ucinet importado y elegimos si queremos obtener la nueva matriz a partir de las filas
(«Row») o partir de las columnas («Column», en el desplegable).

Ilustración 6. Ventana de diálogo de comando «Afiliaciones».
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Si elegimos «Row» obtendremos un fichero llamado Affiliations.##h de 18 x 18 listo
con la siguiente matriz:

1 1 1 1 1 1 1 1 1

1 2 3 4 5 6 7 8 9 0 1 2 3 4 5 6 7 8

E L T B C F E P R V M K S N H D O F

- - - - - - - - - - - - - - - - - -

1 EVELYN  8 6 7 6 3 4 3 3 3 2 2 2 2 2 1 2 1 1

2 LAURA  6 7 6 6 3 4 4 2 3 2 1 1 2 2 2 1 0 0

3 THERESA  7 6 8 6 4 4 4 3 4 3 2 2 3 3 2 2 1 1

4 BRENDA  6 6 6 7 4 4 4 2 3 2 1 1 2 2 2 1 0 0

5 CHARLOTTE  3 3 4 4 4 2 2 0 2 1 0 0 1 1 1 0 0 0

6 FRANCES  4 4 4 4 2 4 3 2 2 1 1 1 1 1 1 1 0 0

7 ELEANOR  3 4 4 4 2 3 4 2 3 2 1 1 2 2 2 1 0 0

8 PEARL  3 2 3 2 0 2 2 3 2 2 2 2 2 2 1 2 1 1

9 RUTH  3 3 4 3 2 2 3 2 4 3 2 2 3 2 2 2 1 1

10     VERNE  2 2 3 2 1 1 2 2 3 4 3 3 4 3 3 2 1 1

11     MYRNA  2 1 2 1 0 1 1 2 2 3 4 4 4 3 3 2 1 1

12 KATHERINE  2 1 2 1 0 1 1 2 2 3 4 6 6 5 3 2 1 1

13    SYLVIA  2 2 3 2 1 1 2 2 3 4 4 6 7 6 4 2 1 1

14      NORA  2 2 3 2 1 1 2 2 2 3 3 5 6 8 4 1 2 2

15     HELEN  1 2 2 2 1 1 2 1 2 3 3 3 4 4 5 1 1 1

16   DOROTHY  2 1 2 1 0 1 1 2 2 2 2 2 2 1 1 2 1 1

17    OLIVIA  1 0 1 0 0 0 0 1 1 1 1 1 1 2 1 1 2 2

18     FLORA  1 0 1 0 0 0 0 1 1 1 1 1 1 2 1 1 2 2

Un simple análisis de f-Groups (una técnica que busca grupos internamente den-
sos y débilmente conectados que está disponible en Network>Subgroups>
f-Groups) de esta matriz nos muestra la existencia de dos grupos de mujeres bien
definidos (Ilustración 7).

Group 1:

EVELYN LAURA THERESA BRENDA CHARLOTTE FRANCES ELEANOR RUTH

Group 3:

VERNE MYRNA KATHERINE SYLVIA NORA HELEN

Levels of Ties Among Actors

Por otra parte, un análisis de las columnas también puede sernos de utilidad. Proce-
deríamos de la misma forma pero seleccionando «Column» en lugar de «Row». 
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Cómo recodificar matrices

Ucinet 6 dispone de un amplio conjunto de procedimientos para manipular matrices. De
todos ellos destacaremos la opción

Transform>Recode

Este procedimiento consta de dos partes (pestaña «Files» y pestaña «Recode», Ilus-
tración 8). En la pestaña Files, podemos seleccionar el fichero con los datos, las filas y
las columnas que queremos recodificar. El botón L nos permite seleccionar diferentes
subconjuntos de filas o columnas, presionando la tecla Crtl y clicando las etiquetas de
fila o columna correspondientes. Si no especificamos nada, la remodificación afectará
a toda la matriz. 

Ilustración 7. Análisis de F-Groups de Ucinet 6.

Ilustración 8. Opción «Recode» de Ucinet 6.
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Por último, en la pestaña Recode podemos especificar un conjunto de reglas de reco-
dificación. Siguiendo con el ejemplo de los jóvenes que se mueven en la noche barce-
lonesa, podemos introducir el criterio de convertir en «0» todos los desplazamientos de
menos de 15 jóvenes y en «1» todos los desplazamientos de 15 o superior (Ilustra-
ción 9).

Si clicamos la tecla Add dispondremos de las dos reglas definidas. El resultado de
la recodificación (matriz Recjovenes) es el siguiente:

1 1 1 1 1 1 1 1 1 1 2 2 2 2 2

1 2 3 4 5 6 7 8 9 0 1 2 3 4 5 6 7 8 9 0 1 2 3 4

A B C D E F G H I J K L M N Ñ O P Q R S T U V W

- - - - - - - - - - - - - - - - - - - - - - - -

1 A 1 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0

2 B 1 1 0 0 0 1 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0

3 C 1 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0

4 D 0 0 0 1 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0

5 E 0 0 0 0 1 1 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0

6 F 0 0 0 0 0 1 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0

7 G 1 0 0 0 0 1 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0

8 H 1 0 0 0 0 0 0 1 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0

9 I 1 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0

10 J  1 0 0 0 0 0 0 0 0 0 1 0 0 0 0 0 0 0 0 0 0 0 0 0

Ilustración 9. Recodificación de los valores de una matriz.
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Si representamos gráficamente la matriz con NetDraw obtendremos una imagen bas-
tante parecida a la que obtuvimos en la ilustración 6 (Ilustración 10).

Ilustración 10. Grafo de la matriz recodificada de traslado nocturno de jóvenes en Barcelona.





El análisis de redes sociocéntricas con Ucinet 6 y Netdraw

Águeda Quiroga
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Introducción

Este taller tiene como objetivo introducir conceptos básicos del análisis de datos reticu-
lares (o análisis de redes sociales), utilizando UCINET 6 y NetDraw1. Los contenidos
de este manual surgen de tres fuentes principales:

— Hanneman, Robert A., Introducción a los métodos de análisis de redes sociales.
Departamento de Sociología de la Universidad de California Riverside.
http://wizard.ucr.edu/~rhannema/netwprks/text/textindex.html Versión en castellano en
http://www.redes-sociales.net/materiales.

— Molina, José Luis (2001), El análisis de redes sociales. Una introducción. Barcelona:
Edicions Bellaterra. 

— Wasserman, Stanley and Faust, Katherine (1994), Social network Analysis. Methods
and Applications. Cambridge MA: Cambridge University Press. 

Pero ¿qué es el análisis de redes sociales? Veamos una definición:

El análisis de redes sociales se ocupa del estudio de las relaciones entre una serie defi-
nida de elementos (personas, grupos, organizaciones, países e incluso acontecimientos).
A diferencia de los análisis tradicionales que explican, por ejemplo, la conducta en fun-
ción de la clase social y la profesión, el análisis de redes sociales incorpora las relacio-
nes y no sólo los atributos de los elementos. (Molina, op.cit: p. 13).

La particularidad del análisis de redes sociales radica entonces en el énfasis en las
relaciones entre los elementos estudiados, entre sus propiedades relacionales, y no exclu-
sivamente en las características monádicas (atributos individuales) de cada elemento.  

Como señala Hanneman (op.cit), los datos sociológicos «tradicionales» se represen-
tan en una matriz rectangular en donde se inscriben las mediciones. En las filas se ubi-
can los casos u observaciones (personas, organizaciones, países, etc.), y en las colum-
nas, las variables seleccionadas (edad, tipo de organización, población, etc.). En cambio,
en el análisis de redes sociales

(…) los datos de la ‘red’ (en su forma más pura), constituyen una matriz cuadrada de medi-
ciones. Las filas de la matriz son los casos, sujetos u observaciones. Las columnas son
el mismo conjunto de casos, sujetos y observaciones –allí está la diferencia clave con los
datos convencionales. En cada celda de la matriz se describe una relación entre los acto-
res (p. 5).

1. Borgatti, S.P. 2002. NetDraw: Graph Visualization Software. Harvard: Analytic Technologies
http://www.analytictech.com.
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En las tablas 1 y 2 se presenta un ejemplo de los dos tipos de matrices señaladas por
Hanneman. La primera se fija en las características de los individuos. La segunda, en las
relaciones que mantienen dichos individuos entre sí. Así, se ha marcado con 1 la presen-
cia de la relación de amistad y con 0 su ausencia. 

Los elementos básicos del análisis de redes sociales son, entonces, los nodos (los
puntos que representan a personas, grupos, países, etc.) y la relación o vínculo que nos
interesa analizar (amistad, enemistad, parentesco, comercio, etc.) y que se establece
entre tales nodos. 

Descripción del ejercicio práctico

Comenzaremos trabajando con un ejemplo sencillo, a fin de introducir los conceptos
básicos. Analizaremos las relaciones de conocimiento mutuo de un curso de estudian-
tes universitarios. Contamos con el listado de estudiantes (nombre y sexo) y la carrera
a la que pertenecen. Además, cada uno de ellos ha respondido un cuestionario en el que
se les preguntaba a quiénes de los demás integrantes de la clase conocían personalmente
antes de iniciar el curso. 

Así, los nodos serán en este caso los estudiantes, y el vínculo a analizar será la rela-
ción de conocimiento previo. Conviene precisar bien a qué propiedad relacional nos refe-
rimos. No se trataba en este caso de preguntar quiénes eran amigos de quiénes, ni de si
algún estudiante tenía conocimiento indirecto de otro (ambos casos resultan problemáti-
cos por diversas razones). Se trata de la propiedad «conocer a», que en nuestro estudio
(y en el cuestionario) se entendía como tener un mutuo conocimiento personal (que no
tiene por qué implicar relación continuada, pero sí alguna interacción pasada). Con los
datos de las tablas 3 y 4 elaboraremos las matrices que utilizaremos para el análisis

Informante Edad Sexo Ocupación 

FFG 32 Mujer Secretaria administrativa 

BNM 20 Hombre Estudiante 

DFP 45 Hombre Funcionario público 

CCD 37 Mujer Abogada

STR 26 Mujer Docente 

Tabla 1. Matriz con datos sociológicos «convencionales».

Tabla 2. Matriz con datos relacionales.

¿Quién es amigo de quién?

FFG BNM DFP CCD STR 

FFG - 1 0 0 1

BNM 1 - 1 0 0

DFP 0 1 - 1 1

CCD 0 0 1 - 0

STR 1 0 1 0 -
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Tabla 3. Listado de estudiantes.

Tabla 4. Resultado del cuestionario.

Nombre Sexo (M/F) Carrera

Andrés M Antropología

Carlos M Arqueología

Carme F Arqueología

Carmen F Antropología

Carol F Arqueología

Dolors F Antropología

Hugo M Sociología

Joan M Antropología

José M Psicología Social

Julio M Antropología

Liliana F Sociología

María F Psicología Social

Mariano M Arqueología

Martha F Arqueología

Nuria F Psicología Social

Pau M Antropología

Xavi M Psicología Social

Nombre Conoce a 

Andrés Carlos, Carmen, Dolors, Joan, Julio, Pau 

Carlos Carme, Carol, Andrés 

Carme Carlos, Carol 

Carmen Andrés, Dolors, Pau 

Carol Carlos, Carme 

Dolors Andrés, Carmen, José 

Hugo Liliana 

Joan Andrés, Julio, Pau, José 

José Dolors, Joan, María, Nuria, Xavi 

Julio Andrés, Joan 

Liliana Hugo 

María José, Nuria, Xavi 

Mariano Martha, Pau 

Martha Mariano, Pau 

Nuria José, María 

Pau Andrés, Carmen, Joan, Martha, Mariano 

Xavi José, María 
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Crear una matriz con Ucinet 6

El primer paso en nuestro análisis de redes del ejemplo planteado consiste en construir
una matriz con la información de que disponemos, a fin de poder analizarla y graficarla.
Para eso, utilizaremos el programa Ucinet 6. 

Al iniciar dicho programa Ucinet 6 nos encontramos con la pantalla de la ilustra-
ción 1.

Al operar en un entorno Windows, el programa presenta características comunes a
los programas elaborados para este sistema operativo. Cuenta con una barra de menús
desplegables (File, Data, Transform, Tools, Network, Draw, Options, Help) más una
serie de iconos de acceso directo. Si nos fijamos en la ilustración 1, veremos que en la
parte inferior hay un rectángulo blanco, donde se lee «C:\Documents and Settings\ Pro-
pietario\Mis documentos». Esta dirección nos indica el directorio en el que estamos tra-
bajando, y en el que por defecto guardará los archivos. Para definir otra carpeta o direc-
torio se debe hacer seleccionar 

File> Change Default Folfer

Esta operación es importante hacerla en primer lugar. 
A continuación debemos introducir nuestros datos. Para ello activaremos la función

«Spreadsheet» (el segundo icono desde la izquierda, ver la Ilustración 2 y siguientes).
Antes de continuar con la introducción de datos en la matriz es conveniente realizar

una aclaración sobre los tipos de vínculos. Los lazos o vínculos pueden ser orientados
o no orientados (por ejemplo, conocimiento previo como una relación no orientada, pres-
tar dinero a alguien como una relación orientada). Pero, por otra parte, también pueden
ser o binarios o valorados. Son binarios cuando medimos la ausencia o presencia de la
relación. En el caso que estamos analizando, si dos personas se conocen previamente le

Ilustración 1. Ucinet 6.



damos el valor 1 y si no, 0. Pero también podríamos querer valorar el tipo de relación
que tienen dos personas, ponderando el vínculo, por ejemplo, entre 0 si no hay conoci-
miento, 1 si son apenas conocidos, 2 si son conocidos con una relación continuada, 3 si
son amigos y 4 si son amigos muy cercanos. A lo largo de este ejemplo sólo trabajare-
mos con vínculos no orientados y binarios, pero es importante recordar que se pueden
utilizar también vínculos orientados y vínculos valorados, y que dentro de estos existe
una gran pluralidad de variantes2.

Dado que, como hemos dicho, en nuestro ejemplo los vínculos no son orientados,
cambiaremos la función a «Symmetric» (Ilustración 3) e introduciremos los nombres
de los estudiantes en las filas y luego los copiaremos en las columnas

Labels> Copy rows to columns

2. Para más información sobre los tipos de vínculos y las escalas de medida, véase Hanneman, op.cit, cap 1:17-22.
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Ilustración 2. Hoja de datos con los estudiantes.

Ilustración 3. Relación existente entre los estudiantes (conocimiento previo).
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Hemos introducido ya los nodos de la red que queremos analizar. A continuación
introduciremos los valores de la relación. Así, siguiendo la información de la tabla 5,
introduciremos manualmente la información correspondiente a cada par de personas.
Introduciremos un 1 si hay relación y dejaremos la celda en blanco si no la hay.

Una vez completa nos ubicaremos en la última celda (en este caso, en la intersección
de la columna 17 con la fila 17) y desde allí haremos

Fill> Blanks w/0s

De esta manera, se completarán con ceros el resto de las celdas de la matriz. 
Hemos completado así la matriz con las relaciones. La guardaremos con el nombre

«estudiantes» (a partir del menú File> Save as).

A continuación crearemos dos nuevas matrices, en las que almacenaremos los datos
atributivos de la tabla 3 (sexo y carrera a la que pertenecen los estudiantes). Recorde-
mos que los datos atributivos son propiedades individuales, y por lo tanto no relaciona-
les, de los nodos que son objeto de nuestro análisis. Para ellos, abriremos la matriz que
acabamos de crear (File>Open>estudiantes.##h) y realizaremos nuevamente la ope-
ración «Save as». Llamaremos «carrera» a este nuevo fichero (File>Save as>carrera).  

Introduciremos en esta matriz (carrera.##h) los datos correspondientes a la carrera
universitaria que estudian los alumnos de la clase. Para aprovechar el listado de los nom-
bres, eliminaremos la información de las columnas. Seleccionamos con el ratón las 17
columnas y apretamos la tecla «Suprimir» o «Delete».

Una vez borrada la información de las columnas, cambiaremos el modo de la matriz
a «Normal» (esta matriz ya no será cuadrada como la anterior, sino que tendrá 17 filas
y 1 columna). Escribimos en el encabezado de la columna 1 (en la zona coloreada debajo
del número 1) «carrera» (sin las comillas). Introduciremos en esa columna la informa-
ción codificada de la siguiente manera: 1 para los estudiantes de antropología, 2 para
los de arqueología, 3 para los de sociología y 4 para los de Psicología social (Ilustra-
ción 4).

Guardamos la matriz y elegimos «yes» en la opción guardar cambios. 
A continuación, abrimos la matriz que acabamos de crear (File>Open>carrera.##h)

y la guardamos con el nombre «sexo» (File>Save as>sexo). Realizamos sobre esta
matriz la misma operación que en el caso anterior (borramos la columna 1) y escribimos

Ilustración 4. Datos atributivos de los estudiantes (carrera).
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como encabezado de la misma «sexo» (sin comillas) e introducimos la información codi-
ficada de la siguiente manera: 1 para varones y 2 para mujeres.

Cerramos la matriz y guardamos los cambios. Hemos introducido ya toda la infor-
mación que utilizaremos en este taller.

Graficar una red con Netdraw

A continuación, veremos la representación gráfica de la primera matriz que hemos cre-
ado, la que resume la información sobre las relaciones existentes entre los estudiantes. 

Una vez cerrada la función «Spreadsheet», regresamos a la pantalla inicial de Uci-
net 6. Allí hacemos un click sobre el icono que abre el programa NetDraw (el séptimo
icono contando desde la izquierda). Se abre así una ventana con el programa NetDraw.
Este programa se utiliza para visualizar gráficamente redes sociales. Veremos represen-
tada en grafos la matriz que hemos introducido. Para ello, abriremos la matriz «estu-
diantes.##h» que hemos creado anteriormente desde:

File>Open>Ucinet dataset>Network

Al abrirla obtenemos el gráfico de la ilustración 5.
Vemos representadas gráficamente las relaciones que habíamos introducido en la

matriz. Así, por cada par de personas que habíamos conectado en la matriz (mediante el
1 que señalaba la relación) observamos un vínculo que une los dos nodos. Como se trata
de una relación no orientada, cada grafo tiene una doble flecha (Hugo conoce a Liliana
y Liliana conoce a Hugo). Un grafo no orientado también se representa como un segmento
que une dos nodos, sin ninguna flecha que indique dirección. 

Esta red sociométrica presenta una fotografía de las relaciones que existen al inte-
rior de un grupo (la clase, en este caso). A simple vista podemos observar que existen
individuos más conectados que otros, que existen sub-grupos dentro de la red, etc. Podría-
mos entonces intentar establecer hipótesis acerca de las relaciones existentes. Por ejem-

Ilustración 5. Red de los estudiantes con NetDraw.
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plo, podríamos suponer que las personas que cursan las mismas carreras se relacionan
más entre sí que las de carreras diferentes. Para ello, necesitamos complementar la infor-
mación con los datos atributivos que hemos recopilado. 

Para ello, añadiremos la matriz que contiene la información sobre las carreras a la
matriz que representaba las relaciones de conocimiento y que ya hemos realizado. La ope-
ración es muy sencilla. Sin salir de la red de estudiantes (Ilustración 6) realizamos:

File>Open>Ucinet dataset>Attribute Data

Y seleccionamos el fichero «carrera.##h». 

Ilustración 7. Cambiando los colores de las categorías de la variable atributiva «carrera».

Ilustración 6. Red de estudiantes y la información sobre sus estudios.
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Veremos los cuatro códigos que hemos introducido para las carreras, cada uno de
ellos asociado a un color diferente. Si quisiéramos cambiar el color adjudicado a alguno,
sólo hay que hacer click sobre el rectángulo de color que se encuentra a la izquierda del
código y seleccionar el color que deseamos en la paleta que se despliega. En este caso,
cambiaremos el color correspondiente al código 2, de negro a verde (Ilustración 7).

Una vez efectuado el cambio, hacemos click sobre el botón «Aceptar». Vemos enton-
ces que a cada persona le corresponde el color de la carrera que está estudiando: rojo para
Antropología, verde para Arqueología, azul para Sociología y gris para Psicología Social
(Ilustración 8). 

A continuación, introduciremos los datos correspondientes al sexo, utilizando for-
mas diferentes para los nodos, según representen hombres o mujeres. Introducimos
entonces la matriz correspondiente al sexo (sexo.##h). Y seleccionamos la función «Cho-
ose node shapes according to attribute values» (tercer icono contando desde la derecha).
Se abrirá una ventana similar a la que utilizamos para definir los colores. Seleccionamos
el atributo «sexo». Un consejo: si en el menú desplegable («select attibute») no vemos
el atributo que queremos introducir, debemos descender hacia el final de la ventana,
hasta encontrarlo. 

A continuación seleccionaremos un triángulo para identificar a los hombres (codi-
ficados con el valor «1») y un círculo para identificar a las mujeres (codificadas con el
valor «2») (Ilustración 9).

Ilustración 8. Representación de la red con el atributo correspondiente.

Ilustración 9. Variable atributiva «sexo».
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De esta manera hemos introducido los dos atributos en la red. Y obtenemos el resul-
tado que muestra la ilustración 10.

Hemos conseguido una descripción más detallada de la red de interacciones. Como
podemos observar en la ilustración 10, existen subgrupos en el interior de nuestra red así
como personas con más conexiones que otras. Así, los que cursan la carrera de Antro-
pología (marcados en rojo) se conocían todos entre sí antes de iniciar el curso. Lo mismo
pasa con los estudiantes de Psicología Social (nodos grises) y los de Sociología (nodos
azules). Sin embargo, no sucede lo mismo con los estudiantes de Arqueología (verde),
entre los que podemos observar dos grupos diferenciados. Por el contrario, no parece
haber ningún patrón diferenciado de relación entre hombres y mujeres. 

En lo que hace a las personas, algunos estudiantes sólo conocen a una o dos perso-
nas del grupo, mientras que otras (como Andrés o Joan) conocen a mucha gente. Pero
para saber con certeza cuáles son las características de esta red, recurriremos al cálculo
de las medidas de centralidad, a fin de realizar una primera aproximación al análisis de
esta red social. Antes de pasar a esta sección, exportaremos la imagen de la red que
hemos obtenido, para poder utilizarla posteriormente. Para ello, desde la función «File»
de la barra de menús seleccionamos la función «Save diagram as» y luego el formato que
elijamos (en este caso, «Bitmap») (Ilustración 11).

La guardaremos con el nombre «redestudiantes». Para concluir la primera parte de
la práctica, crearemos un documento en Word (con el nombre «informe práctica.doc»)
e insertaremos la imagen que hemos creado (Insertar>Imagen>Desde archivo).
(Ilustración 12).

Seleccionamos la imagen a insertar («redestudiantes»), y guardamos los cambios
realizados en el informe.

Ilustración 10. Red social con indicación del sexo (forma) y los estudios (color).
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Ilustración 12. Insertando una red en Word.

Ilustración 11. Guardando la red como imagen.
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Medidas de centralidad

Como señala Hanneman (op. cit.)

La perspectiva de redes implica tener en cuenta múltiples niveles de análisis. Las dife-
rencias entre los actores son interpretadas en base a las limitaciones y oportunidades que
surgen de la forma en que éstos están inmersos en las redes; la estructura y el compor-
tamiento de las redes está basado en y activado por las interacciones locales entre los acto-
res. (...) Las diferencias en cómo los individuos están conectados puede ser extremada-
mente útil para entender sus atributos y comportamiento. Muchas conexiones significan
a menudo que los individuos se exponen todavía a más y más diversa información. 
(cap V: p. 3) 

Podemos realizar una primera aproximación a la estructura de una red social mediante
el análisis de tres medidas de centralidad: rango (degree), grado de intermediación (bet-
weenness) y cercanía (closeness). Por medida de centralidad se entiende un conjunto de
algoritmos calculado sobre cada red que nos permite conocer la posición de los nodos
en el interior de la red y la estructura de la propia red. Veamos qué significa cada una de
estas medidas, cómo se calculan y cómo se interpretan.

Grado nodal (degree) 

El grado nodal o rango es el número de lazos directos de un actor (o nodo), es decir con
cuántos otros nodos se encuentra directamente conectado. Si volvemos a la figura 23, por
ejemplo, podemos observar que Martha está conectada a dos personas: Mariano y Pau.
Su rango, entonces es 2. Andrés, en cambio, conoce a seis personas: su rango es 6. En
este caso es sencillo calcularlo a simple vista. Pero para trabajar con mayor precisión,
utilizaremos Ucinet 6. Desde el menú «Network» seleccionaremos la función «Centra-
lity» y luego «Degree» (Ilustración 13).

En la pantalla que se despliega seleccionaremos la matriz que contiene los datos que
queremos analizar. En este caso, analizaremos la matriz «estudiantes.##h», la que con-
tiene la información sobre las relaciones de conocimiento entre los estudiantes de la

Ilustración 13. Calculando el grado nodal (Degree) con Ucinet 6.

Jose Luis
Tachado

Jose Luis
Texto insertado
10

Jose Luis
Nota
Atenció
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clase. Para ello, haremos click con el ratón en el botón de la fila «imput dataset» (mar-
cado con tres puntos) (Ilustración 14).

La primera fila («Input dataset») indica el fichero que utilizará para calcular el rango.
La segunda fila («Treat data as symmetric») pregunta si se trata de una matriz simétrica
(la relación de A-B vale para B-A) o no. En este caso, la respuesta es «sí». La tercera
fila (Include diagonal values?) pregunta si debe tener en cuenta los valores de la diago-
nal (la relación entre A y A, B y B, C y C, etc.), y responderemos «no». La cuarta fila
informa con qué nombre se guardarán los resultados, en el directorio que tengamos pre-
determinado. Haciendo click en el icono de los tres puntos, se puede definir otro direc-
torio y modificar el nombre del archivo con los datos de salida si así lo deseamos. Una
vez realizados los cambios que queremos hacer, hacemos click en «aceptar». Obtenemos
la pantalla de la ilustración 15.

Vemos la lista de todos los nodos de la red, ordenados de mayor rango (más número
de conexiones) a menor rango (menor número de conexiones). Se reproduce en la tabla
de la página siguientela información obtenida en las tres primeras columnas (Cuadro 1).

La columna «Nrmdegree» indica el rango normalizado, es decir, el porcentaje de
conexiones que tiene un nodo sobre el total de la red. 

El análisis del rango o grado nodal nos indica que la persona más conectada en este
grupo, la de mayor centralidad, es Andrés, y que Liliana y Hugo son los menos centra-
les, con un rango de 1 cada uno. Podríamos suponer que Andrés es la persona que con-
trola mayor cantidad de información. El grado nodal puede ser considerado una medida
que permite acceder al índice de accesibilidad a la información que circula por la red.
Si, por ejemplo, en el interior del grupo circularan ciertos rumores, los actores con un 

Ilustración 14. Seleccionando el fichero «estudiantes».

Ilustración 15. Resultados del cálculo del grado nodal.
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grado nodal más alto tendrán mayores probabilidades de escucharlos y difundirlos. El
rango también puede ser interpretado como el grado de oportunidad de influir o ser
influido por otras personas en la red. Pongamos por ejemplo el caso de la red que esta-
mos analizando. Supongamos que nos interesa realizar algunas modificaciones en el
dictado de la asignatura o que queremos conocer la valoración de los estudiantes sobre
su desarrollo. En este caso Andrés (con un grado nodal de 6, el más alto de la red) parece
ser un buen informante, alguien que tiene acceso a bastante información de la que cir-

Degree NrmDegree

Andrés 6.0 37.500

Pau 5.0 31.250

José 5.0 31.250

Joan 4.0 25.000

Carlos 3.0 18.750

Dolors 3.0 18.750

Carmen 3.0 18.750

María 3.0 18.750

Carme 2.0 12.500

Nuria 2.0 12.500

Carol 2.0 12.500

Mariano 2.0 12.500

Xavi 2.0 12.500

Julio 2.0 12.500

Martha 2.0 12.500

Liliana 1.0 6.250

Hugo 1.0 6.250

Ilustración 16. Estadísticos descriptivos del cálculo del grado nodal.

Cuadro 1.
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cula por el grupo. Podemos utilizar el rango también, por ejemplo, como un método de
selección de personas para entrevistas o negociaciones.

Pero debemos complementar este análisis con las otras medidas de centralidad, para
obtener un panorama más completo. Antes de hacerlo, nos referiremos a los estadísticos
descriptivos que acompañan la información (Ilustración 16).

Los estadísticos descriptivos brindan información sobre los valores que tomó el
rango en el conjunto de la red. Vemos que el rango promedio de la red («Mean») es
2.824, y que los valores oscilan entre 1 y 6 (la menor y mayor cantidad de lazos).  

Incorporaremos esta información al informe de la práctica, de manera muy sencilla:
seleccionamos con el ratón el texto y seleccionamos la función «copiar» (Edit>Copy).
Pegamos la información en el informe en Word que estamos elaborando
(Edición>Pegar).

Grado de intermediación (betweenness) 

El grado de intermediación indica la frecuencia con que aparece un nodo en el tramo
más corto (o geodésico) que conecta a otros dos. Es decir, muestra cuando una persona
es intermediaria entre otras dos personas del mismo grupo que no se conocen entre sí (lo
que podríamos denominar «persona puente»). Veamos cuáles son los valores para el
grado de intermediación en nuestra red para localizar un ejemplo. 

Para calcular el grado de intermediación seleccionamos el menú Network>
Centrality>Betweenness>Nodes:

En la pantalla que se despliega elegimos la matriz que contiene los datos que vamos
a analizar («estudiantes.##h») y hacemos click en el botón «ok». Obtenemos como resul-
tado el valor del grado de intermediación de cada nodo, ordenados de mayor a menor (Ilus-
tración 17).

Ilustración 17. Resultados del cálculo del grado de intermediación.
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Se reproducen a continuación los resultados obtenidos: 

Andrés y José son las personas con un mayor grado de intermediación. Si observa-
mos la figura 23 vemos que Andrés es la persona que conecta al grupo de los antropó-
logos con uno de los grupos de los arqueólogos (el formado por Carlos, Carme y Carol)
y José conecta al grupo de los estudiantes de psicología social con los de antropología.
Pero Joan, Pau y Carlos también tienen valores altos de grado de intermediación. La
relación entre Joan y Pau permite conectar tres grupos: arqueólogos, antropólogos y psi-
cólogos sociales. En el caso de Carlos, su relación con Andrés vincula a Carol y Carme
con un grupo mayor. Si esa relación se rompiese, el grupo quedaría aislado. 

Realizaremos la misma operación que en el caso del rango: seleccionaremos los
resultados obtenidos y con la función «copiar» incorporaremos la información en el
documento del informe.

Cercanía (closenness) 

El grado de cercanía indica la cercanía de un nodo respecto del resto de la red. Repre-
senta la capacidad que tiene un nodo de alcanzar a los demás. Veremos su interpreta-
ción a partir de un ejemplo. 

Para calcularlo, procederemos de la misma manera que en las dos medidas de cen-
tralidad anteriores, es decir, a partir del menú «Network» (Network>Centrality>
Closenness). Seleccionamos el archivo a analizar y damos click en el botón «ok». El
resultado de la operación, al igual que en los casos anteriores, es la lista ordenada de los
valores de cercanía, y también el de su opuesto, lejanía (farness) (Ilustración 18).

Betweenness nBetweenness

Andrés 39.0 32.5

José 34.0 28.3

Joan 25.5 21.2

Pau 24.5 20.4

Carlos 24.0 20.0

Dolors 12.0 20.0

Carmen 1.5 10.0

María 0.5 1.2

Carme 0.0 0.4

Hugo 0.0 0.0

Carol 0.0 0.0

Liliana 0.0 0.0

Mariano 0.0 0.0

Julio 0.0 0.0

Nuria 0.0 0.0

Martha 0.0 0.0

Xavi 0.0 0.0

Jose Luis
Tachado

Jose Luis
Texto insertado
10

Jose Luis
Nota
Atenció



Talleres de autoformación con programas de análisis de redes sociales Materials 39

Se reproducen a continuación los resultados:

Al igual que en las dos medidas de centralidad anteriormente analizadas, Andrés es
la persona de la red que cuenta con un grado de cercanía más grande. Tiene una mayor
capacidad para acceder al resto de los nodos de la red. Sin embargo, los resultados para
el resto de las personas no son iguales a los obtenidos en las mediciones anteriores. Si

Farness Closeness

Andrés 59.0 27.11

Joan 60.0 26.66

Pau 62.0 25.80

Dolors 63.0 25.39

José 64.0 25.00

Carmen 64.0 25.00

Julio 67.0 23.88

Carlos 68.0 23.52

Mariano 74.0 21.62

Martha 74.0 21.62

Maria 75.0 21.33

Nuria 76.0 21.05

Xavi 76.0 21.05

Carme 80.0 20.0

Carol 80.0 20.0

Liliana 256.0 6.25

Hugo 256.0 6.25

Ilustración 18. Cálculo de la cercanía.
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volvemos a los resultados del grado nodal vemos que, por ejemplo, Dolors tenía el mismo
rango que Carlos, Carmen y María (conocían a tres personas cada uno). Sin embargo,
el grado de cercanía de Dolors es mayor que el de ellos. No sólo es importante el número
de personas que conoces, sino quiénes son esas personas, cuál es su grado de conexio-
nes. Si observamos la red vemos que Dolors conoce a Andrés y a José, las dos personas
con mayor grado de cercanía de toda la red. De esta manera, su probabilidad de acceder
al resto de los nodos es más alta. «Una persona poco conectada con el resto (baja cen-
tralidad, bajo grado de intermediación) por el solo hecho de estar conectada con una
persona ‘importante’ puede tener una alta cercanía» (Molina, op.cit: p. 79). 

Finalizaremos ahora el ejercicio, copiando los resultados y llevándolos al informe que
hemos elaborado.

Redes dentro de redes: cliques 

Regresemos ahora al gráfico de nuestra red. Una característica que podemos observar a
simple vista es que dentro de ella es posible identificar grupos o sub-grafos. Por ejem-
plo, Carlos, Carme y Carol constituyen un grupo: están relacionados entre ellos (de
hecho, tienen se encuentran más vinculados entre ellos que con el resto de la red). Este
subgrupo recibe el nombre técnico de clique (si bien, como veremos posteriormente,
podríamos hablar de dos acepciones de clique: en sentido «duro» y en sentido «blando»).
Un clique (en sentido «blando») es un grupo dentro de una red.  

El análisis de sub-grafos, o de cliques, es un tipo de aproximación a la estructura de
la red, una aproximación de «abajo hacia arriba», como señala Hanneman (op. cit.):

La noción [de clique] parte de los vínculos simples para «construir» la red. Un mapa de
toda la red puede ser construido examinando los tamaños de los distintos cliques y agru-
paciones de tipo de clique, notando sus tamaños y yuxtaposiciones. Este tipo de aproxi-
mación, acerca de las subestructuras de las redes, tienden a enfatizar cómo lo macro
puede surgir de lo micro. Tienden a enfocar nuestra atención primero en los individuos
y en entender cómo están inmersos en la estructura mayor de la red a partir de los gru-
pos yuxtapuestos. Esta idea aparentemente obvia se tiene que destacar porque también
es posible aproximarse a la cuestión de la subestructuras de las redes desde una pers-
pectiva de arriba hacia abajo. Ambos aspectos son valiosos y complementarios. (cap V:
p. 6) 

Ucinet permite analizar las subestructuras de la red, a partir de una serie de medi-
das de agrupamiento, que revisaremos a continuación 

Cliques 

Hemos utilizado anteriormente la palabra clique como sinónimo de subgrupo dentro de
una red. Pero en sentido estricto se denomina clique a un conjunto de nodos o actores
que tienen todos los vínculos posibles entre ellos. Los actores que conforman un clique
deben ser más de dos, por lo general se trabajan cliques de tres y más integrantes. Un
grupo de nodos que tienen entre ellos todos los vínculos posibles se denomina «sub-
grafo máximo completo». 

Pediremos a Ucinet que identifique todos los cliques de más de tres integrantes que
se encuentran en nuestra red. Para ello, desde la pantalla inicial de Ucinet seleccionare-
mos el menú «Network» y luego Subgroups>Cliques (Ilustración 19).
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En el cuadro de diálogo que se despliega (que es muy similar a los que utilizamos
con las medidas de centralidad) seleccionaremos en primer lugar la matriz en donde se
encuentran los datos que queremos analizar (Imput dataset). En este caso es la que hemos
estado utilizando hasta ahora (estudiantes.##h). La segunda opción es el número mínimo
de integrantes del clique. La opción por defecto es 3 y en este caso la mantendremos. 
A continuación se nos pregunta si queremos que se analice el patrón de superposiciones
(Analyze pattern of overlaps). Esto significa que podemos saber cuándo un integrante
de un clique pertenece a otros, y con cuales miembros de la red comparte cliques. Es
una información muy interesante, que analizaremos con más detalle cuando veamos los
resultados. Ignoraremos por ahora el resto de las opciones, ya que es necesario que en
primer lugar aprendamos las cuestiones básicas de esta medida (Ilustración 20). 

Ilustración 19. Localizando cliques en la red.

Ilustración 20. Ventana de diálogo de la opción Cliques.
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Al hacer click en «OK» obtenemos la pantalla de la ilustración 21.
El primer dato que obtenemos es que se han encontrado 8 cliques en nuestra red.

Transcribo a continuación los resultados: 

Ningún clique en nuestra red tiene más de tres integrantes. Podemos decir que esta
red está conformada por pequeñas subestructuras con un alto grado de solapamiento
(Andrés, por ejemplo, es integrante de la mitad de los cliques). Pero el grado de solapa-
miento se observa con claridad cuando analizamos la matriz de superposiciones (que
transcribo a continuación):

Actor-by-Actor Clique Co-Membership Matrix 

1 1 1 1 1 1 1 1

1 2 3 4 5 6 7 8 9 0 1 2 3 4 5 6 7

a c c c c d h j j j l m m m n p x

- - - - - - - - - - - - - - - - -

1 andres  4 0 0 2 0 1 0 2 0 1 0 0 0 0 0 2 0 

2 carlos  0 1 1 0 1 0 0 0 0 0 0 0 0 0 0 0 0 

3 carme  0 1 1 0 1 0 0 0 0 0 0 0 0 0 0 0 0 

4 carmen  2 0 0 2 0 1 0 0 0 0 0 0 0 0 0 1 0 

5 carol  0 1 1 0 1 0 0 0 0 0 0 0 0 0 0 0 0 

6 dolors  1 0 0 1 0 1 0 0 0 0 0 0 0 0 0 0 0 

7 hugo  0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 

8 joan  2 0 0 0 0 0 0 2 0 1 0 0 0 0 0 1 0 

9 jose  0 0 0 0 0 0 0 0 2 0 0 2 0 0 1 0 1 

10   julio  1 0 0 0 0 0 0 1 0 1 0 0 0 0 0 0 0 

11 liliana  0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 

12   maria  0 0 0 0 0 0 0 0 2 0 0 2 0 0 1 0 1 

13 mariano  0 0 0 0 0 0 0 0 0 0 0 0 1 1 0 1 0 

14  martha  0 0 0 0 0 0 0 0 0 0 0 0 1 1 0 1 0 

15   nuria  0 0 0 0 0 0 0 0 1 0 0 1 0 0 1 0 0 

16     pau  2 0 0 1 0 0 0 1 0 0 0 0 1 1 0 3 0 

17    xavi  0 0 0 0 0 0 0 0 1 0 0 1 0 0 0 0 1 

8 cliques found
1 Andrés- Carmen- Dolors 
2 Andrés- Carmen- Pau 
3 Andrés- Joan- Julio 
4 Andrés- Joan- Pau 
5 Carlos- Carme- Carol 
6 José- María- Nuria 
7 José María Xavi 
8 Mariano- Martha- Pau 
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A primera vista, esta matriz puede resultar poco clara. Pero vayamos paso por paso.
La matriz de superposiciones (o de «co-membrecía») brinda tres datos: a cuántos cli-
ques pertenece cada actor, con qué actores comparte cliques y cuánto cliques comparte
con cada uno de ellos. ¿Cómo debe leerse para obtener esta información? 

Para saber a cuántos cliques pertenece cada nodo, leeremos la diagonal de la matriz.
Así, la información sobre el actor 1 (Andrés) se encuentra en la intersección de la columna
1 y la fila 1, la del actor 2 (Carlos), en la intersección de la columna 2 y la fila 2 y así
sucesivamente:

1 1 1 1 1 1 1 1
1 2 3 4 5 6 7 8 9 0 1 2 3 4 5 6 7
a c c c c d h j j j l m m m n p x
- - - - - - - - - - - - - - - - -

1 andres  4 0 0 2 0 1 0 2 0 1 0 0 0 0 0 2 0
2 carlos  0 1 1 0 1 0 0 0 0 0 0 0 0 0 0 0 0
3 carme  0 1 1 0 1 0 0 0 0 0 0 0 0 0 0 0 0
4 carmen  2 0 0 2 0 1 0 0 0 0 0 0 0 0 0 1 0
5 carol  0 1 1 0 1 0 0 0 0 0 0 0 0 0 0 0 0
6 dolors  1 0 0 1 0 1 0 0 0 0 0 0 0 0 0 0 0
7 hugo  0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0
8 joan  2 0 0 0 0 0 0 2 0 1 0 0 0 0 0 1 0
9 jose  0 0 0 0 0 0 0 0 2 0 0 2 0 0 1 0 1

10   julio  1 0 0 0 0 0 0 1 0 1 0 0 0 0 0 0 0
11 liliana  0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0
12   maria  0 0 0 0 0 0 0 0 2 0 0 2 0 0 1 0 1
13 mariano  0 0 0 0 0 0 0 0 0 0 0 0 1 1 0 1 0
14  martha  0 0 0 0 0 0 0 0 0 0 0 0 1 1 0 1 0
15   nuria  0 0 0 0 0 0 0 0 1 0 0 1 0 0 1 0 0
16     pau  2 0 0 1 0 0 0 1 0 0 0 0 1 1 0 3 0
17    xavi  0 0 0 0 0 0 0 0 1 0 0 1 0 0 0 0 1

Ilustración 21. Ventana de datos de los resultados del cálculo de los Cliques.



aJ.L. Molina, A. Quiroga, J. Martí, I. Maya, A. de Federico44 Materials

Como habíamos visto al analizar los cliques, Andrés pertenece a cuatro cliques dife-
rentes, seguido por Pau, que pertenece a tres. La mayoría de los actores sólo pertenece
a uno, mientras que tenemos dos actores aislados, Liliana y Hugo, que no pertenecen a
ninguno, ya que, como vimos en el análisis de la graficación de la red y en las medidas
de centralidad, constituyen una díada aislada del resto de la red. 

Para obtener los otros dos datos que presenta esta matriz (con quién se comparte cli-
que y qué número de cliques se comparte con cada actor), podemos mirar la línea hori-
zontal o la vertical de cada actor:

1 1 1 1 1 1 1 1

1 2 3 4 5 6 7 8 9 0 1 2 3 4 5 6 7

a c c c c d h j j j l m m m n p x

- - - - - - - - - - - - - - - - -

1 andres  4 0 0 2 0 1 0 2 0 1 0 0 0 0 0 2 0

2 carlos  0 1 1 0 1 0 0 0 0 0 0 0 0 0 0 0 0

3 carme  0 1 1 0 1 0 0 0 0 0 0 0 0 0 0 0 0

4 carmen  2 0 0 2 0 1 0 0 0 0 0 0 0 0 0 1 0

5 carol  0 1 1 0 1 0 0 0 0 0 0 0 0 0 0 0 0

6 dolors  1 0 0 1 0 1 0 0 0 0 0 0 0 0 0 0 0

7 hugo  0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0

8 joan  2 0 0 0 0 0 0 2 0 1 0 0 0 0 0 1 0

9 jose  0 0 0 0 0 0 0 0 2 0 0 2 0 0 1 0 1

10   julio  1 0 0 0 0 0 0 1 0 1 0 0 0 0 0 0 0

11 liliana  0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0

12   maria  0 0 0 0 0 0 0 0 2 0 0 2 0 0 1 0 1

13 mariano  0 0 0 0 0 0 0 0 0 0 0 0 1 1 0 1 0

14  martha  0 0 0 0 0 0 0 0 0 0 0 0 1 1 0 1 0

15   nuria  0 0 0 0 0 0 0 0 1 0 0 1 0 0 1 0 0

16     pau  2 0 0 1 0 0 0 1 0 0 0 0 1 1 0 3 0

17    xavi  0 0 0 0 0 0 0 0 1 0 0 1 0 0 0 0 1

Podemos observar, por ejemplo, que Andrés no comparte ningún clique con Carlos
o Carme, pero comparte dos cliques con Carmen, Joan y Pau, y uno con Dolors y con
Julio. O que Dolors comparte un clique con Andrés y otro con Carmen, y ninguno más
con el resto de los actores de la red, y constatar el aislamiento de Liliana y Hugo. Pero
también podemos analizar qué cliques comparten miembros entre sí. En este caso, nues-
tra unidad ya no son los actores, sino los cliques.
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Clique-by-Clique Co-membership matrix 

1 2 3 4 5 6 7 8

- - - - - - - -

1 6 2 1 1 0 0 0 0

2 2 6 1 2 0 0 0 1

3 1 1 6 2 0 0 0 0

4 1 2 2 6 0 0 0 1

5 0 0 0 0 6 0 0 0

6 0 0 0 0 0 6 2 0

7 0 0 0 0 0 2 6 0

8 0 1 0 1 0 0 0 6

Esta matriz presenta en las filas y las columnas los cliques y leeremos la línea ver-
tical o la horizontal, ignorando la diagonal: 

1 2 3 4 5 6 7 8

- - - - - - - -

1 6 2 1 1 0 0 0 0

2 2 6 1 2 0 0 0 1

3 1 1 6 2 0 0 0 0

4 1 2 2 6 0 0 0 1

5 0 0 0 0 6 0 0 0

6 0 0 0 0 0 6 2 0

7 0 0 0 0 0 2 6 0

8 0 1 0 1 0 0 0 6

Vemos que el clique Nº 1 (integrado por Andrés, Carmen y Dolors) comparte dos inte-
grantes con el clique Nº 2 (integrado por Andrés, Carmen y Pau). Andrés y Carmen son
los dos integrantes que se repiten en ambos cliques. El clique Nº 1 también comparte un
integrante con el clique Nº 3 y con el Nº 4 (Andrés es el integrante que se repite en ambos
casos). 

A continuación, copiaremos los resultados obtenidos en un documento de word, que
guardaremos con el nombre de «informe practica 2») (Ilustración 22).
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N-clique, N-clan y K-plex 

Como señala Hanneman (op. cit) en algunas ocasiones, la definición «dura» de clique
(sub-grafo máximo completamente conectado) es demasiado estricta para nuestros fines.
Puede interesarnos conocer cliques en los que algunos de sus miembros no estén conec-
tados con todos los demás integrantes, por ejemplo. Existen una serie de medidas de
agrupación que relajan la condición de subgrafo máximo completo: N-clique, N-clan y
K-plex, que revisaremos a continuación. 

Según la primera medida, N-clique, un actor es miembro de un clique si está conec-
tado con todos los miembros del grupo a una distancia mayor que uno. Generalmente se
utiliza una distancia de dos (lo que equivale a ser amigo de un amigo). 

Aplicaremos N-clique a nuestros datos. Para ellos, seleccionaremos el menú 
Network y a continuación Subgroups>N-cliques.

En el cuadro de diálogo que se despliega, seleccionaremos en primer lugar la matriz
que contiene los datos a analizar (estudiantes.##h). La segunda opción nos indica el
tamaño de la n (la distancia que estableceremos). Mantendremos la opción por defecto,
que es 2. La tercera opción es el tamaño mínimo de los cliques que identificaremos (man-
tedremos 3) y la cuarta nos pregunta si queremos obtener la matriz de superposiciones
o co-membrecía (selecionaremos «yes»). Como en el caso del análisis de cliques, igno-
raremos ahora el resto de las posibilidades (Ilustración 23). 

Obtenemos el resultado que muestra la ilustración 24.

Ilustración 22. Guardando los resultados en Word.
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La primera diferencia en relación con el análisis anterior es que hemos obtenido tres
cliques menos (ahora son cinco) pero de mayor tamaño. En efecto, la condición «conozco
a alguien que lo conoce» nos devuelve grupos más grandes. Reproduzco a continuación
los resultados de la primera matriz:

Se han identificado dos cliques con siete miembros, dos con seis y uno con cuatro.
N-clique es una medida mucho más inclusiva que clique. Por esta razón es importante

Ilustración 24. Resultados de N-Cliques.

Ilustración 23. Ventana de diálogo de N-Cliques.

5 2-cliques found. 

1 andres carmen dolors joan jose julio pau 

2 dolors joan jose maria nuria xavi 

3 andres carlos carmen dolors joan julio pau 

4 andres carmen joan mariano martha pau 

5 andres carlos carme carol
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ser cuidadosos a la hora de utilizarla, ya que podrían incluirse dentro de un mismo grupo
actores que realmente no tienen una pertenencia clara. 

En lo que hace a los actores que integran cada grupo, vemos que Andrés continua
teniendo un protagonismo importante (integra cuatro de los cinco cliques). Pero aparece
una modificación: ya no es el único actor destacado, sino que tenemos a otro actor (Joan)
integrando también cuatro cliques. Joan ha doblado su participación respecto de la medi-
ción anterior. Y este caso es un buen ejemplo para graficar la diferencia entre clique y
N-clique. De acuerdo con las medidas de centralidad que hemos calculado anterior-
mente, Joan tiene un rango de 4, es decir, conoce a cuatro personas en la red: Andrés,
Julio, Pau y José. Cuando calculamos los cliques, vimos que, de acuerdo con los datos
de la tabla 4, Joan forma un clique junto con Andrés y Julio y otro con Andrés y Pau.
No integra ningún clique con José, que es la cuarta persona que conoce en la red, ya que
no tiene relación con el resto de los integrantes de estos cliques (José forma un clique
con María y Nuria y otro con María y Xavi). Pero al aligerar la condición de la relación,
a través de N=2, tenemos que pertenece al clique Nº 1 porque conoce directamente a
Andrés, Julio, José y Pau, e indirectamente a Carmen (a través de Andrés o de Pau) y a
Dolors (a través de José o de Andrés). En el clique Nº 2 sólo conoce directamente a José,
pero «hereda» sus relaciones con María, Nuria y Xavi, y llega nuevamente a Dolors a
través de Andrés o de Pau (aunque ellos no integren el clique. Retomaremos este punto
en el análisis de N-clan). El mismo proceso sucede en los cliques Nº 3 y 4. 

Veamos ahora la matriz de solapamientos o co-membrecía. Leeremos la diagonal en
primer lugar: 

1 1 1 1 1 1 1 1
1 2 3 4 5 6 7 8 9 0 1 2 3 4 5 6 7
a c c c c d h j j j l m m m n p x
- - - - - - - - - - - - - - - - -

1 andres  4 2 1 3 1 2 0 3 1 2 0 0 1 1 0 3 0
2 carlos  2 2 1 1 1 1 0 1 0 1 0 0 0 0 0 1 0
3 carme  1 1 1 0 1 0 0 0 0 0 0 0 0 0 0 0 0
4 carmen  3 1 0 3 0 2 0 3 1 2 0 0 1 1 0 3 0
5 carol  1 1 1 0 1 0 0 0 0 0 0 0 0 0 0 0 0
6 dolors  2 1 0 2 0 3 0 3 2 2 0 1 0 0 1 2 1
7 hugo  0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0
8 joan  3 1 0 3 0 3 0 4 2 2 0 1 1 1 1 3 1
9 jose  1 0 0 1 0 2 0 2 2 1 0 1 0 0 1 1 1

10   julio  2 1 0 2 0 2 0 2 1 2 0 0 0 0 0 2 0
11 liliana  0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0
12   maria  0 0 0 0 0 1 0 1 1 0 0 1 0 0 1 0 1
13 mariano  1 0 0 1 0 0 0 1 0 0 0 0 1 1 0 1 0
14  martha  1 0 0 1 0 0 0 1 0 0 0 0 1 1 0 1 0
15   nuria  0 0 0 0 0 1 0 1 1 0 0 1 0 0 1 0 1
16     pau  3 1 0 3 0 2 0 3 1 2 0 0 1 1 0 3 0
17    xavi  0 0 0 0 0 1 0 1 1 0 0 1 0 0 1 0 1

Tenemos dos actores pertenecientes a cuatro cliques cada uno, tres a tres cliques,
tres a dos  y siete a uno. Ha aumentado el número de cliques de partencia, pero al igual
que en eser caso, Liliana y Hugo están aislados del resto de la red. Respecto de la co-
participación (leyendo la línea vertical u horizontal) vemos lo siguiente: 

Jose Luis
Tachado

Jose Luis
Texto insertado
pertenencia

Jose Luis
Nota
Atenció
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1 1 1 1 1 1 1 1

1 2 3 4 5 6 7 8 9 0 1 2 3 4 5 6 7

a c c c c d h j j j l m m m n p x

- - - - - - - - - - - - - - - - -

1 andres  4 2 1 3 1 2 0 3 1 2 0 0 1 1 0 3 0

2 carlos  2 2 1 1 1 1 0 1 0 1 0 0 0 0 0 1 0

3 carme  1 1 1 0 1 0 0 0 0 0 0 0 0 0 0 0 0

4 carmen  3 1 0 3 0 2 0 3 1 2 0 0 1 1 0 3 0

5 carol  1 1 1 0 1 0 0 0 0 0 0 0 0 0 0 0 0

6 dolors  2 1 0 2 0 3 0 3 2 2 0 1 0 0 1 2 1

7 hugo  0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0

8 joan  3 1 0 3 0 3 0 4 2 2 0 1 1 1 1 3 1

9 jose  1 0 0 1 0 2 0 2 2 1 0 1 0 0 1 1 1

10   julio  2 1 0 2 0 2 0 2 1 2 0 0 0 0 0 2 0

11 liliana  0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0

12   maria  0 0 0 0 0 1 0 1 1 0 0 1 0 0 1 0 1

13 mariano  1 0 0 1 0 0 0 1 0 0 0 0 1 1 0 1 0

14  martha  1 0 0 1 0 0 0 1 0 0 0 0 1 1 0 1 0

15   nuria  0 0 0 0 0 1 0 1 1 0 0 1 0 0 1 0 1

16     pau  3 1 0 3 0 2 0 3 1 2 0 0 1 1 0 3 0

17    xavi  0 0 0 0 0 1 0 1 1 0 0 1 0 0 1 0 1

Ha aumentado el número de actores con los que se comparte clique. Esto se debe a
la mayor inclusividad que tiene N-clique en relación con clique. Si vemos los resulta-
dos obtenidos ahora por los dos actores que tomamos como ejemplo a la hora de anali-
zar la co-membrecía en la tabla 9, Andrés y Dolors, vemos que en ambos casos ha aumen-
tado el número de personas con los que comparten clique: Andrés pasa de 5 a 11 y Dolors
de 2 a 11. Y además aumenta el número de participaciones compartidas con cada actor. 

Una manera de restringir N-clique es utilizando N-clan. Como hemos mencionado,
en ocasiones al aplicar N-clique se muestra conectividad a través de actores que no son
miembros del clique (el caso de la relación entre Dolors y Joan, en el clique 2, mediada
por actor que no formaba parte de ese clique). Si en cambio utilizamos N-clan, introdu-
cimos una cláusula en el análisis: la relación continúa siendo mediada (accedo a alguien
porque es conoce a una persona que yo conozco) pero todos los vínculos deben alcan-
zarse mediante otros miembros del clique. 

Veamos lo que sucede con nuestros datos cuando aplicamos N-clan. El procedi-
miento es similar al resto de las medidas de agrupamiento: (Menú Network>
Subgroups>N-clan).

El cuadro de diálogo es como los que habíamos utilizado anteriormente: seleccio-
namos la matriz que contiene los datos; determinamos el valor de N (que este caso será
2, al igual que en N-clique); pedimos cliques de tres o más integrantes y analizaremos
el patrón de superposiciones (Ilustración 25).

Obtenemos la pantalla de resultados (Ilustración 26).
Los resultados son muy similares a los obtenidos mediante N-clique: cinco cliques.

Veamos su composición: 

Jose Luis
Tachado

Jose Luis
Texto insertado
matriz de la página 44

Jose Luis
Nota
Atenció
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Aunque la composición es idéntica al caso de N-clique (ya que la definición de N-
clique se encuentra incluida en la de N-clan), el procedimiento es diferente Veamos el
ejemplo de Andrés. Pertenece al clan Nº 5 por su relación con Carlos, ya que no conoce
directamente a Carme o a Carol. Pero no podría invocar a ningún otro actor para perte-
necer al clan si este no perteneciera también. N-clan es un modificación menor de N-cli-
que, y como hemos observado en el ejemplo, en muchos casos se obtienen idénticos
resultados, pero ambas medidas se complementan, ya que permiten asegurarnos de que
los actores que incluimos en un clique realmente pertenecen a él. 

La última medida que analizaremos es K-plex. Su definición es muy sencilla: un
actor puede ser miembro de un clique siempre y cuando tenga vínculos directos con
todos excepto K miembros del grupo. 

Ilustración 25. Ventana de diálogo de N-Clan.

Ilustración 26. Resultados N-Cliques.

5 2-clans found. 

1 andres carmen dolors joan jose julio pau 

2 dolors joan jose maria nuria xavi 

3 andres carlos carmen dolors joan julio pau 

4 andres carmen joan mariano martha pau 

5 andres carlos carme carol



Talleres de autoformación con programas de análisis de redes sociales Materials 51

Hanneman dice que, si bien 

(…) el enfoque K-plex parece tener bastante en común con el N-clique, el análisis basado
en K-plex a menudo arroja un cuadro bastante diferente de las sub-estructuras del grafo.
En vez de las agrupaciones grandes y concatenadas que a veces produce el análisis 
N-clique, el análisis K-plex tiende a encontrar número relativamente grandes de peque-
ñas agrupaciones. Esto tiende a llamar la atención sobre yuxtaposiciones y co-presen-
cia (centralización) más que en solidaridad y accesibilidad (cap. V: p. 11).

K-plex, entonces, muestra información sobre círculos sociales superpuestos. Vea-
mos qué sucede cuando aplicamos K-plex a nuestros datos. Daremos a K el valor de 2
(un actor será miembro de un clique si conoce a todos menos dos actores del mismo).
Seleccionamos el menú Network>Subgroups>K-plex. El cuadro de diálogo es
similar a todos los anteriores. Seleccionamos el documento a analizar, determinamos el
valor de K (2), declaramos que los grupos deben tener 3 o más integrantes y pedimos la
matriz de superposiciones (Ilustración 27).

Obtenemos el resultado de la ilustración 28.

Ilustración 27. Ventana de diálogo de K-plex.

Ilustración 28. Resultados de K-Plex.
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Nuestra red consta de 31 K-plex, es decir 31 subgrupos en donde un actor conoce a
todos los integrantes menos a dos. Transcribo los resultados de la primera tabla: 

31 k-plexes found.

1 andres carlos carme 

2 andres carlos carmen 

3 andres carlos carol 

4 andres carlos dolors 

5 andres carlos joan 

6 andres carlos julio 

7 andres carlos pau 

8 andres carmen dolors pau 

9 andres carmen joan pau 

10 andres carmen julio 

11 andres dolors joan jose 

12 andres dolors julio 

13 andres joan julio pau 

14 andres mariano pau 

15 andres martha pau 

16 carlos carme carol 

17 carmen dolors jose 

18 carmen mariano pau 

19 carmen martha pau 

20 dolors jose maria 

21 dolors jose nuria 

22 dolors jose xavi 

23 joan jose julio 

24 joan jose maria 

25 joan jose nuria 

26 joan jose pau 

27 joan jose xavi 

28 joan mariano pau 

29 joan martha pau 

30 jose maria nuria xavi 

31 mariano martha pau 
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Vemos una gran mayoría de K-plexes de tres integrantes (26) y sólo cinco con más
de tres. Andrés es el actor que se repite mayor cantidad de veces, como podemos com-
probar al mirar la matriz de superposiciones: está presente en 15 grupos. Pero también
hay otros actores con participaciones importantes. Al utilizar esta medida, todos los acto-
res aumentan el número de cliques a los que perteneces.

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 

an ca ca ca ca do hu jo jo ju li ma ma ma nu pa xa 

— — — — — — — — — — — — — — — — —

1 andres  15 7 1 4 1 4 0 4 1 4 0 0 1 1 0 6 0

2 carlos   7  8 2 1 2 1 0 1 0 1 0 0 0 0 0 1 0

3 carme   1  2  2 0 1 0 0 0 0 0 0 0 0 0 0 0 0

4 carmen   4  1  0  7 0 2 0 1 1 1 0 0 1 1 0 4 0

5 carol   1  2  1  0  2 0 0 0 0 0 0 0 0 0 0 0 0

6 dolors   4  1  0  2  0  8 0 1 5 1 0 1 0 0 1 1 1

7 hugo   0  0  0  0  0  0  0 0 0 0 0 0 0 0 0 0 0

8 joan   4  1  0  1  0  1  0 11 6 2 0 1 1 1 1 5 1

9 jose   1  0  0  1  0  5  0  6 11 1 0 3 0 0 3 1 3

10   julio   4  1  0  1  0  1  0  2  1  5 0 0 0 0 0 1 0

11 liliana   0  0  0  0  0  0  0  0  0  0  0 0 0 0 0 0 0

12   maria   0  0  0  0  0  1  0  1  3  0  0  3 0 0 1 0 1

13 mariano   1  0  0  1  0  0  0  1  0  0  0  0  4 1 0 4 0

14  martha   1  0  0  1  0  0  0  1  0  0  0  0  1  4 0 4 0

15   nuria   0  0  0  0  0  1  0  1  3  0  0  1  0  0  3 0 1

16     pau   6  1  0  4  0  1  0  5  1  1  0  0  4  4  0 12 0

17    xavi   0  0  0  0  0  1  0  1  3  0  0  1  0  0  1  0  3
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Algo similar observamos al analizar la línea horizontal (o vertical):

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 

an ca ca ca ca do hu jo jo ju li ma ma ma nu pa xa 

— — — — — — — — — — — — — — — — —

1 andres  15  7 1 4 1 4 0 4 1 4 0 0 1 1 0 6 0

2 carlos   7 8 2 1 2 1 0 1 0 1 0 0 0 0 0 1 0

3 carme   1 2 2 0 1 0 0 0 0 0 0 0 0 0 0 0 0

4 carmen   4 1 0 7 0 2 0 1 1 1 0 0 1 1 0 4 0

5 carol   1 2 1 0 2 0 0 0 0 0 0 0 0 0 0 0 0

6 dolors   4 1 0 2 0 8 0 1 5 1 0 1 0 0 1 1 1

7 hugo   0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0

8 joan   4 1 0 1 0 1 0 11  6  2  0  1  1  1  1  5  1 

9 jose   1 0 0 1 0 5 0 6 11  1  0  3  0  0  3  1  3 

10   julio   4 1 0 1 0 1 0 2 1 5 0 0 0 0 0 1 0

11 liliana   0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0

12   maria   0 0 0 0 0 1 0 1 3 0 0 3 0 0 1 0 1

13 mariano   1 0 0 1 0 0 0 1 0 0 0 0 4 1 0 4 0

14  martha   1 0 0 1 0 0 0 1 0 0 0 0 1 4 0 4 0

15   nuria   0 0 0 0 0 1 0 1 3 0 0 1 0 0 3 0 1

16     pau   6 1 0 4 0 1 0 5 1 1 0 0 4 4 0 12 0

17    xavi   0 0 0 0 0 1 0 1 3 0 0 1 0 0 1 0 3

Aumenta el número de cliques que se comparten con el resto de integrantes de la
red. Pero, siguiendo a Hanneman, eliminaremos los cliques de sólo tres integrantes, ya
que nos dan poca información adicional (sólo hace falta conocer a un miembro para for-
mar parte del grupo). Repetiremos el procedimiento, pero esta vez declararemos que el
tamaño mínimo del grupo deberá ser de 4 nodos. Trancribo a continuación los resulta-
dos obtenidos:

Sólo existen cinco sub.grupos que cumplan con las características solicitadas. Y una
vez más Andrés es el actor más destacado, con cuatro participaciones. Pero también lo
son Joan y Pau, con tres participaciones cada uno.

1 andres carmen dolors pau

2 andres carmen joan pau

3 andres dolors joan jose 

4 andres joan julio pau

5 jose maria nuria xavi
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1 1 1 1 1 1 1 1

1 2 3 4 5 6 7 8 9 0 1 2 3 4 5 6 7

a c c c c d h j j j l m m m n p x

- - - - - - - - - - - - - - - - -

1 andres  4 0 0 2 0 2 0 3 1 1 0 0 0 0 0 3 0

2 carlos  0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0

3 carme  0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0

4 carmen  2 0 0 2 0 1 0 1 0 0 0 0 0 0 0 2 0

5 carol  0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0

6 dolors  2 0 0 1 0 2 0 1 1 0 0 0 0 0 0 1 0

7 hugo  0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0

8 joan  3 0 0 1 0 1 0 3 1 1 0 0 0 0 0 2 0

9 jose  1 0 0 0 0 1 0 1 2 0 0 1 0 0 1 0 1

10   julio  1 0 0 0 0 0 0 1 0 1 0 0 0 0 0 1 0

11 liliana  0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0

12   maria  0 0 0 0 0 0 0 0 1 0 0 1 0 0 1 0 1

13 mariano  0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0

14 martha   0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0

15   nuria  0 0 0 0 0 0 0 0 1 0 0 1 0 0 1 0 1

16     pau  3 0 0 2 0 1 0 2 0 1 0 0 0 0 0 3 0

17    xavi  0 0 0 0 0 0 0 0 1 0 0 1 0 0 1 0 1

K-plex presenta grupos más «legítimos» en cierto sentido, ya que elimina la presen-
cia de los intermediarios (tengo que conocer directamente a todos los miembros menos
a dos, en este caso). 

Al igual que en el caso de las medidas de centralidad, las medidas de agrupamiento
son complementarias, y la combinación de ellas nos devuelve una imagen más ajustada
de la estructura de la red. 

Para terminar con este ejercicio, pegaremos los resultados obtenidos en el docu-
mento de Word. 
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Existen dos perspectivas diferentes para el estudio de las redes sociales: la sociocéntrica
y la egocéntrica. La perspectiva sociocéntrica suele identificar para cada contexto ins-
titucional una red diferente. Así, si utilizamos como generador de nombres, «señala por
favor a quiénes elegirías como representantes de esta lista», o «dime a quién pedirías
prestado dinero», la red de respondientes y personas nominadas será diferente en cada
caso. Naturalmente, podemos recoger diferentes contextos y combinarlos, pero la pers-
pectiva sigue siendo la misma: un conjunto definido de personas o actores que tienen rela-
ciones entre sí por algún tipo de relación (o contexto institucional) previamente defi-
nido. 

La perspectiva egocéntrica, en cambio, parte de un ego o punto focal y se interroga
por todas las relaciones existentes. Naturalmente, de esta forma se recogen (o se debe-
rían recoger) todos los contextos institucionales en los que se mueve ego, es decir, fami-
lia, vecinos, compañeros de estudio o trabajo, grupo religioso o cualquier institución
relevante para su vida social. Estas instituciones varían según la cultura, naturalmente. 

Ahora bien, ¿cómo recoger o aproximarse la miríada de interacciones que se produ-
cen alrededor de una persona? La respuesta a esta pregunta depende también de la pers-
pectiva adoptada. En general podemos afirmar que las redes personales están constitui-
das por un centro de lazos fuertes que cambia lentamente a lo largo de la vida y una
periferia más amplia y dinámica. El tamaño de esta red varía enormemente en la escala
social, de forma que las personas con cargos políticos o administrativos de importancia
suelen tener unas redes muy amplias comparadas con las redes de personas marginales
en una sociedad. Si atendemos a las relaciones acumuladas a lo largo de una vida (muchas
de ellas se olvidan) el resultado es de 3500 personas (Cf. Molina, 2005 para una expli-
cación detallada de los métodos). Si atendemos a las relaciones estables, podemos iden-
tificar una media de unas 300 personas, con una desviación típica importante en fun-
ción de la clase social y el sexo. Si atendemos a las relaciones fuertes e íntimas, el número
se puede reducir a menos de una veintena. En la ilustración 1 podemos apreciar estas dife-
rencias.

Christopher McCarty (2002) sugiere un cambio en el enfoque del estudio de redes
personales, pasando de la estimación del tamaño a la estimación de la estructura de las
redes personales. La pregunta es: ¿cuál es el mínimo de número de alteri sobre los que
hay que indagar para disponer de una idea aproximada de la estructura de la red per-
sonal? McCarty propone que un número entre 30 y 45  personas tiene que ser suficiente
si el generador de nombres utilizado permite obtener una lista libre de personas de todas
las categorías sociales. Por ejemplo:

Por favor, díganos una lista de 40 personas que Ud. conozca. Intente que todas las cate-
gorías importantes de personas (parientes, amigos, compañeros, vecinos...) estén repre-
sentados en la lista.



aJ.L. Molina, A. Quiroga, J. Martí, I. Maya, A. de Federico58 Materials

El generador utilizado tiende a producir lazos íntimos al principio, pero la lista es lo
suficientemente larga como para recoger información de diferentes áreas de la estruc-
tura de las redes personales, incluidos los lazos débiles. A continuación es necesario
indagar sobre quién conoce a quién, aparte de recoger datos atributivos sobre ego y los
alteri. Esta parte es la más larga pues una lista de 40 personas implica 780 preguntas de
si dos personas se conocen o tienen algún tipo de relación que interese recoger. Para
obtener esta información es necesaria la ayuda del programa Egonet. Por último, se pre-
senta un informe a ego sobre su propia red personal. En todos los casos, los informan-
tes se han mostrado sorprendidos por la calidad de la información mostrada sobre sus
propias redes. 

El estudio de las redes personales tiene la inmensa ventaja que permite aplicar los
métodos de muestreo de poblaciones (a diferencia del enfoque sociocéntrico) y que los
resultados acerca de la composición y la estructura de cada red personal pueden ser con-
vertidos en variables atributivas de los casos y formar parte de los modelos explicativos
sobre una variedad de temas (salud, discursos, rendimiento académico, aculturación …).

En este ejercicio realizaremos tres actividades. La primera, con el módulo de admi-
nistración de Egonet, diseñaremos un cuestionario que nos permita aproximarnos a nues-
tra propia red personal. La segunda actividad consistirá en recoger datos de nuestra red
personal (y, en su caso, la de otras personas) y visualizarla y analizarla con Visualizer,
el módulo de visualización incorporado en Egonet. La tercera actividad consistirá en
exportar los datos recogidos a SPSS. 

Ilustración 1. Las diferentes estimaciones del tamaño de la red personal.
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Notas sobre la instalación de Egonet

Puede descargarse una versión de prueba de 60 días de Egonet de la página de MDlo-
gix: http://www.mdlogix.com/egonet.htm#purchasing.

Módulo administrador (Egonet_QB)

El módulo Administrador de Egonet se llama Egonet_ QB (Egonet Q- Builder, admi-
nistrador de cuestionarios). Una vez clicamos el icono aparece la pantalla que muestra
la ilustración 2.

Introduciremos, en la versión de prueba, la misma serie de caracteres: nimh y cli-
caremos Ok. La pantalla que obtendremos será la de la que muestra la ilustración 3.

Ilustración 2. Pantalla de identificación de Egonet_QB.

Ilustración 3. Pantalla de QBuilder.
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A continuación Seleccionaremos File>New Study y, en la parte derecha de la
pantalla, escribiremos «Red personal» en el campo Study Name y fijaremos en 30 el
número de nominados o alteri («Nominees») (Ilustración 4).

Los módulos que componen QBuilder son «Questions about Ego», las variables
identificativas de Ego, «Name Generador(s)», la pregunta o preguntas que utilizaremos
para generador nombres o nominaciones de personas, «Questions about Alters», las
variables que pediremos para cada una de las personas nominadas y «Alter tie evalua-
tion», la pregunta que utilizaremos para saber si dos personas nominadas tienen algún
tipo de relación entre sí. 

Questions about Ego

Si seleccionamos la primera opción, «Questions about Ego» obtendremos una pantalla
que nos permitirá introducir una información estática que permanecerá en la pantalla
del usuario durante toda la fase de recogida de variables atributivas de Ego. Esta infor-
mación (totalmente opcional) puede aparecer tanto en la parte superior como en la parte
inferior de la pantalla. Introduciremos el rótulo «En este apartado le pediremos alguna
información sobre Ud.» Para la cabecera y «Estudio de la red personal» en el pie según
muestra la ilustración 5.

Ya estamos en condiciones de crear preguntas para cada Ego. La información Ego
ID, Nombre y Apellido aparece automáticamente cuando se ejecuta Egonet, por lo que
no es necesario introducir estas preguntas. Clicaremos el botón Create New Item e
introduciremos la primera pregunta, la edad de Ego (Ilustración 6).

Observamos que en el campo Text se introduce el literal de la pregunta, en el campo
Variable name, una cadena de un máximo de 5 caracteres (en este caso solamente
hemos utilizado 4: edad) y en Answer Type hemos seleccionado «Numeric» para

Ilustración 4. Módulos de QBuilder.



Talleres de autoformación con programas de análisis de redes sociales Materials 61

Ilustración 5. Pantalla de entrada al módulo de preguntas sobre Ego.

Ilustración 6. Variable atributiva de Ego.
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poder introducir directamente los años como un número entero. Siempre estaremos a
tiempo después de convertir la edad en categorías en SPSS. 

Si clicamos el botón Create New Ego Item podremos introducir una nueva varia-
ble, el sexo en este caso. Para ello introducimos un literal («¿Es Ud. hombre o mujer?),
el nombre de la variable («sexo») y seleccionamos el botón Selections (si en Answer
type figura la opción «Categorical»). Al hacerlo se nos abre una ventana de gestión de
categorías. Obsérvese que una vez creado un conjunto de categorías para una respuesta
resta disponible para los nuevos estudios. En este caso utilizaremos la categoría dispo-
nible Sex_esp, que es la que nos interesa y clicaremos el botón Select (Ilustración 7).

En el caso de no disponer de las categorías adecuadas podemos crear una nueva de
la siguiente forma: clicando Add (botón izquierdo de la pantalla), introduciendo «sexo»
en el espacio superior derecho («Current selected category:»), clicando Add (botón dere-
cho de la pantalla), introduciendo «Hombre», «1», «1» y clicando otraz vez Add e intro-
duciendo «Mujer», «2», «2» y clicando Select. La columna «Score» nos indica el valor
que se introducirá en la celda SPSS, mientras que el valor «Sequence» nos indica el
número de orden en la ventana de selección de categorías. 

Podemos así ir introduciendo las categorías que estimados de interés para nuestra inves-
tigación. Para borrar una variable, simplemente nos colocamos en el panel izquierdo,
seleccionamos la variable y clicamos el botón derecho del ratón para obtener la opción
de borrar.

Name genearator(s)

En el siguiente módulo de QBuilder disponemos de nuevo de la opción de informar al
usuario en la cabecera y el pié de la pantalla. En este caso dejaremos en blanco los cam-
pos, clicaremos el botón Create New Item e introduciremos «Lista libre nombres» en
el campo Title y la expresión «Díganos nombres de personas que conozca por su nom-
bre de pila y viceversa y con las que haya tenido al menos algún contacto personal en
los dos últimos años y con la que sea posible contactar de nuevo si fuese necesario.
Intente que todas las categorías de contactos estén representados». Seleccionaremos a
continuación «First Name Only» en el campo Format (siempre es útil trabajar con
acrónimos, por ejemplo MigCer para Miguel de Cervantes) y clicaremos el botón Cre-
ate new name generador Item.

Ilustración 7. Gestor de categorías.
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Questions about alters

En este módulo introduciremos variables atributivas del mismo modo que el módulo
para Ego. En este caso introduciremos también la edad, el sexo y la categoría ocupacio-
nal. Otras variables, como la nacionalidad o la ciudad de residencia habitual, exigi-
rían bien un listado de países adaptado a los respondientes, bien un espacio en blanco
para la introducción de un literal. Es importante limitar el número de variables de este
módulo, pues cada variable tendrá que ser contestada 30 veces (una vez por cada alter
o persona nominada). 

Crearemos las siguientes preguntas (Egonet sustituye automáticamente $$ por el
nombre de cada alter):

— «¿La edad aproximada de $$ es …?» (numérica), nombre de la variable edada.
— «¿El sexo de $$ es …? (categórica, sex_esp), nombre de la variable sexoa.
— «¿La categoría ocupacional de $$ es, de una escala de 0 a 5 (0 dependiente, trabajador/a

doméstico … a 5, directivo/a, responsable político de alto nivel) es …»? (numérica),
nombre de la variable cat_o.

Si hemos realizado correctamente estas operaciones, el aspecto de QBuilder debe-
ría ser el que muestra la ilustración 8.

Y ahora nos resta el módulo final. 

Ilustración 8. Construcción del cuestionario con QBuilder.
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Alter tie evaluation

En este módulo introduciremos una sola pregunta para relacionar los alteri entre sí. Esta
pregunta es la siguiente:

— «¿$$ y $$ se relacionarían entre sí Ud no estuviese?» (categórica, «Muy probable-
mente (2), probablemente (1), no es probable (0)», nombre de la variable: relac).

Una vez completado el cuestionario guardaremos el estudio (File>Save all) acep-
tando la ventana de diálogo. 

Con esto ya tenemos creado un estudio en la base de datos Psychometrica.gdb. En
esta base de datos podemos ir añadiendo otros estudios. Para ello simplemente tenemos
que clicar un estudio existente (por ejemplo el que acabamos de crear llamado «Red per-
sonal») y pulsando el botón derecho del ratón podemos seleccionar la opción Duplicate
y utilizar ese estudio como punto de partida para realizar las modificaciones que estime-
mos oportunas. También podemos archivar el estudio (opción Archive), para que no
aparezca en la pantalla principal. Si queremos recuperar los estudios archivados solamente
tenemos que seleccionar del menú Tools la opción Study Archive, opción que
nos permitirá activar o archivar los estudios almacenados en la base de datos. 

Con File>Exit saldremos del módulo de administración de Egonet con nuestro
cuestionario listo para ser utilizado.

Módulo cliente (Egonet)

La pantalla de identificación que obtenemos cuando ejecutamos Egonet es la que mues-
tra la ilustración 9.

Una vez introducida la palabra clave (nimh si se trata de la versión de prueba)  y
aceptando, obtenemos una pantalla informativa de los estudios disponibles. En este caso
disponemos del estudio «Red personal» pero podríamos seleccionar uno de una lista de
estudios disponibles. Si clicamos el botón Next obtenemos la pantalla que muestra la ilus-
tración 10.

Egonet está diseñado para recoger cientos de entrevistas a partir de un estudio o
cuestionario. Por ello es posible iniciar una nueva entrevista («Start Interview»), dejar
una entrevista a medias y continuar («Continue Incomplete Interview»), Visualizar una
entrevista completa («View Completed Interview») o Borrar una entrevista («Delete
Interview»).

Ilustración 9. Pantalla de identificación de Egonet (módulo cliente).
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Si volvemos a clicar el botón Next obtenemos la pantalla que muestra la ilustra-
ción 11. Es recomendable introducir un código único para cada Ego, por ejemplo, 1001,
1002, etc. El nombre y el apellido pueden ser auténticos, pero siempre es recomendable
la utilización de acrónimos. Introducimos, por ejemplo, «1001», «Juan» y «Ruiz» en
cada uno de los tres campos respectivos y continuamos. 

Una vez hemos clicado el botón Start nos aparece la primera pantalla que hemos dise-
ñado previamente, con su cabecera y pie informativos correspondiente al primer módulo
de preguntas sobre Ego (Ilustración 12).

Una vez contestadas las preguntas nos aparece la pantalla correspondiente al segundo
módulo. En todo momento disponemos de una barra informativa sobre el porcentaje de
trabajo de cada módulo que nos resta por cumplir. Una vez introducido el nombre o el
acrónimo debemos aceptar con un Return o Enter (Ilustración 13).

Ilustración 10. Opciones de entrevista con Egonet.

Ilustración 11. Identificación de Ego.
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Ahora viene la parte más larga de la entrevista, la atribución de variables a los alteri. 
Una vez cumplimentada esta parte nos aparece el último módulo de relación, indi-

cando cada pareja de nominados (Ilustración 14).
Se observará que es posible clicar la opción adecuada o bien teclear el número, lo

cual suele ser más rápido. 
Una vez completado este módulo, el ordenador calcula el gráfico resultante y, des-

pués de unos minutos, nos avisa que se han seleccionado todas las relaciones probables.
Seleccionamos la opción de «Muy probablemente» y observamos la red personal resul-
tante (Ilustración 15). 

Ilustración 12. Primera pantalla diseñada previamente con QBuilder.

Ilustración 13. Lista de nominados.
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El módulo de visualización nos permite analizar la red personal. Un ejemplo de aná-
lisis de la red personal mediante combinación de las diferentes variables recogidas se ofrece
en el apartado siguiente. 

Ilustración 14. Módulo cuarto para la relación entre las personas nominadas.

Ilustración 15. Visualización de la red personal.
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La entrevista cualitativa con Visualizer

La visualización de la red personal es un recurso extraordinario para indagar conjunta-
mente con el informante acerca del significado de los diferentes grupos, posición de per-
sonas o distribución de variables de su red personal. En este apartado mostramos un
ejemplo tomado de un proyecto de investigación que ilustra las posibilidades que ofrece
el módulo de visualización de Egonet. Estas entrevistas pueden grabarse utilizando el
mismo ordenador con programas gratuitos con Windows Media Encoder, por ejemplo. 

En este caso se ha escogido como en nuestro ejemplo anterior la opción «Muy pro-
bablemente» (Very likely) y clicando sobre el botón Spring Embedding Layout, el
quinto por la izquierda). El resultado es el que muestra la ilustración 16.

A continuación vamos a realizar un conjunto de manipulaciones en la visualización
que nos permitan introducir un conjunto de variables visuales en la red personal sobre
la estructura y composición de su red. 

Clicando directamente en cada nodo se puede acceder a toda la información intro-
ducida sobre el nodo. Así si clicamos encima de Pam tenemos la pantalla que muestra
la ilustración 17.

Es decir, las variables en la izquierda y su contenido en la derecha de la tabla. 

Ilustración 16. Ejemplo de red personal.
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Clusters o grupos de la red personal

En primer lugar pediremos al informante que nos explique la estructura global de su red.
Para esto nos ayudará la función Analysis>Partitions-Clusters>Hierarchical
Clustering (Ilustración 18).

El resultado es el que muestra la pantalla de la ilustración 19.
La pantalla con los resultados hay que moverla para poder enseñar los grupos y pre-

guntar por su significado. Cuando hayamos acabado simplemente hay que cerrar la pan-
talla de datos. Clicando en cualquier punto de la pantalla se vuelve a la situación origi-
nal.

Ilustración 17. Variables atributivas de un alter.
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Ilustración 19. Clusters de la red personal numerados.

Ilustración 18. Buscando grupos en la red personal.
.
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Grado de intermediación

Vamos a representar en la visualización el grado de intermediación de los nodos con un
color. Para ello haremos lo siguiente: Analysis>Node Centrality. Aparece enton-
ces una ventana y seleccionaremos los cuadros de color y la betweeness centrality (Ilus-
tración 20).

Aceptamos y obtenemos lo que muestra la ilustración 21.
Ahora podemos preguntar sobre los nodos con el tono de color más acusado y tam-

bién sobre el resto, por supuesto.

Ilustración 20. Coloreando la red personal en función del grado de intermediación.
.
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Ilustración 21. Red personal que muestra grupos y grado de intermediación.
.
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Composición: sexo, residencia y otras

A continuación vamos a mostrar dos variables visuales al mismo tiempo (color y forma,
además de la posición) a partir de las variables disponibles sobre la composición de la
red personal. De entrada haremos las siguientes selecciones:

— Color: residencia actual. 
— Forma: sexo (triángulo hombres, círculo mujeres)

Por supuesto se pueden explorar otras variables, las que sean necesarias en función
de los objetivos del estudio. 

Seleccionamos en primer lugar «Shape by attribute» (Ilustración 22).
Elegimos la variable Asex en este caso y seleccionamos las formas adecuadas en

Select, seleccionando antes la categoría a cambiar (Ilustración 23).
Hacemos lo mismo con la segunda, clicamos en el botón Apply y obtenemos lo que

muestra la ilustración 24.

Ilustración 22. Red personal con grupos, color a la que se quiere añadir la forma en función de
una variable.
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Ilustración 23. Añadiendo la forma en función de la variable sexo.
.

Ilustración 24.
.
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A continuación seleccionamos el color, y la variable Aliv, que en este caso signi-
fica dónde viven actualmente (Ilustración 25).

En este caso, la mayor parte de la red vive en los Estados Unidos. 

Ilustración 25. Red personal con indicación de los grupos, el sexo y la residencia de los alteri.
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En función de la información que obtengamos podemos ir mostrando nuevas varia-
bles visuales en la pantalla. Para ello es útil clicar la opción Windows>Show Study
Questions. Así, en el apartado Questions About Alters es posible elegir la variable más
adecuada (Ilustración 26).

Los ejemplos pueden multiplicarse. El siguiente paso será exportar a SPSS todas las
entrevistas realizadas con sus correspondientes variables. 
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Ilustración 26. Funcionalidad que permite ver las preguntas del cuestionario al mismo tiempo
que la visualización.



Las redes sociales son estructuras que cambian a lo largo del tiempo. Sin embargo, la mayo-
ría de los métodos estadísticos que se han desarrollado hasta hoy no tratan la evolución
de la red. En cambio, el programa SIENA (Simulation Investigation for Empirical Net-
work Analysis) es una herramienta de análisis longitudinal de redes sociales. SIENA
corresponde concretamente a un programa de investigación sobre «las dinámicas de las
redes y el comportamiento» liderado por Tom Snijders en la Universidad de Groningen,
en Holanda, que analiza la mutua dependencia de las redes sociales y los comportamien-
tos de los actores.

SIENA es una plataforma en desarrollo a la que cabe considerar todavía un subpro-
ducto (a la vez que una herramienta) de investigación, más que un software dirigido al
usuario promedio. Sin ir más lejos, la aplicación StOCNET, que agrupa hasta cinco pro-
gramas estadísticos diferentes para el análisis de redes sociales (incluyendo a SIENA),
presenta algunos problemas de fiabilidad y «usabilidad». Sin embargo, por sus caracte-
rísticas, constituye uno de los programas de investigación más prometedores en el ámbito
del análisis de redes sociales. Concretamente:

— Permite el análisis longitudinal de las redes sociales.
— Incorpora herramientas de inferencia estadística.
— Y facilita el análisis de la mutua dependencia de las redes y el comportamiento de

los actores. Es decir, las redes pueden ser tratadas como variable dependiente o como
variable independiente1.

El programa, junto con manuales, artículos y otros materiales, puede obtenerse libre
y gratuitamente del sitio Web <http://stat.gamma.rug.nl/snijders/siena.html>.

Con este ejercicio realizamos una presentación no técnica del programa SIENA2.
En primer lugar, presentamos el fundamento teórico y las potencialidades del modelo esta-
dístico con el que opera el programa. A continuación, enumeramos los pasos y opera-
ciones de una sesión básica con SIENA. Finalmente, mostramos un ejemplo de aplica-
ción, analizando la evolución de los intercambios (de preguntas y respuestas) entre los
participantes en una lista de correo electrónico.

El análisis dinámico de redes con Siena

Isidro Maya Jariego
Departamento de Psicología Social, Universidad de Sevilla
Ainhoa de Federico de la Rúa
Institut de Sociologie et d'Anthropologie, Université de Lille 1
Correspondencia con los autores: Isidro Maya Jariego. Departamento de Psicología Social. Universidad de
Sevilla. Campus Ramón y Cajal. 41.018. Sevilla. Correo-electrónico: isidromj@us.es
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1. SIENA analiza simultáneamente los procesos de selección e influencia. Por ejemplo, es muy conocido el fenómeno
por el que los chicos que fuman en la escuela tienden a asociarse entre sí, formando grupos de fumadores. Este hecho
puede ser analizado como un proceso de selección («los chicos que fuman suelen hacerse amigos de otros fumadores»)
o como un proceso de influencia («los chicos que fuman inducen a sus amigos a fumar»). En el primer caso el
comportamiento condiciona la red social de los actores, mientras que en el segundo es la red social la que influye en
el comportamiento. Ambos procesos, en diferente grado, pueden estar presentes simultáneamente en esa tendencia a
la homofilia en las relaciones, y son analizados como un proceso de dependencia mutua en el programa SIENA.

2. Para una exposición detallada del modelo estadístico, véase por ejemplo: Snijders (2005), Snijders et al. (2005). Una
presentación no técnica está disponible en de Federico (2004, 2005).
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El programa Siena: especificaciones de modelo

SIENA es un programa informático que efectúa la estimación estadística de modelos de
medidas repetidas de redes sociales. Las tres características más destacadas de esta pro-
puesta son (a) el desarrollo de la inferencia estadística y (b) la utilización de modelos de
simulación, en (c) el análisis de la evolución de las redes sociales. Para ello, se basa en
el modelo dinámico orientado al actor. Veamos a continuación dichas características,
repasando los presupuestos y los componentes básicos del modelo.

SIENA trabaja con redes totales. Para ello requiere de dos o más matrices, corres-
pondientes a las observaciones en dos o más momentos diferentes de una red total deter-
minada. El modelo analiza los factores que intervienen en el paso de un estado de la red
social al siguiente. Se parte del supuesto de que la estructura condiciona su propia evo-
lución, existiendo una dinámica por la que los actores pretenden maximizar su utilidad
optando por establecer, mantener o suprimir relaciones con otros actores.

La evolución de la red depende de procesos estructurales endógenos, de efectos exó-
genos y de efectos aleatorios:

1. En primer lugar, la estructura de relaciones tiene una lógica endógena, que explica
su propia evolución. Por ejemplo, la red puede estar experimentando un aumento de
la densidad en términos generales, puede estar sometida a la lógica de la reciproci-
dad en las relaciones o puede seguir una dinámica transitiva en su evolución. Todos
ellos son procesos endógenos.

2. En segundo lugar, la evolución puede obedecer a la influencia de variables externas
(ya sean individuales o diádicas). Por ejemplo, la evolución de la red puede depen-
der de las asociaciones que se producen (o no) en función del sexo de los actores, o
en función de la edad. Es frecuente, por poner un caso, que los actores se asocien
cuando comparten una característica determinada: la filiación ideológica, la proce-
dencia geográfica, el nivel de estudios, etcétera.

3. Finalmente, el modelo también tiene en cuenta un componente aleatorio en la evolu-
ción de la red. De esta forma se toma en consideración la «variabilidad no explicada».

Repasemos someramente algunas de las peculiaridades del enfoque estadístico de aná-
lisis. SIENA utiliza simulaciones por ordenador del proceso de evolución de la red,
basándose en aproximaciones aleatorias. En concreto, recurre a procedimientos estadís-
ticos basados en el método de los momentos. Se presume que el cambio latente se pro-
duce de modo continuo entre los períodos analizados. Es recomendable que las dos
observaciones sean cercanas entre sí, pero que al mismo tiempo reflejen un cambio sufi-
ciente como para que la dinámica de la red sea susceptible de investigación. En su puesta
en práctica, los efectos de todas las variables incluidas en el análisis se controlan recí-
procamente.

Un paso clave en la aplicación del programa consiste en la especificación del modelo,
pues nos obliga a seleccionar el conjunto de elementos cuyo efecto queremos valorar
en la evolución de la red (o, en su caso, en la co-variable de comportamiento que que-
ramos introducir). El modelo de SIENA incluye tres elementos:

1. La función de velocidad. Se refiere a la rapidez con la que cambia la variable depen-
diente. Más exactamente refleja la velocidad con la que los actores tienen la opor-
tunidad de cambiar en la variable dependiente (ya sean sus conexiones en la red o
el comportamiento que estemos analizando como co-variable). Con este componente
del modelo se reconoce que la evolución de las redes puede darse con ritmos de cam-
bio diferentes. Por ejemplo, es posible que en una red emergente se produzcan cam-



bios más rápidamente en las primeras etapas de su desarrollo que una vez que las rela-
ciones ya se han construido y estabilizado.

2. La función de utilidad. Es el componente central del modelo, e indica la satisfac-
ción de los actores con la configuración del vecindario de su red local. Se supone que
los actores cambian sus conexiones (o el comportamiento) para aumentar su satis-
facción. Esta función expresa, por ejemplo, la preferencia por relaciones con perso-
nas de iguales características (sexo, edad, estatus...) o la preferencia por personas
populares, disponibles, conocidas de conocidos, etc.

3. La función de dotación. Establece las diferencias entre el establecimiento o la rup-
tura de lazos. Efectivamente, la función de utilidad puede ser diferente dependiendo
de que estemos hablando del establecimiento de nuevas relaciones o de la ruptura de
las mismas. Crear o romper un lazo no son acciones exactamente inversas en térmi-
nos de satisfacción de los actores. Al romper una relación se pierden los recursos no
recuperables que se invirtieron en ella, tales como el tiempo, el afecto etc. Otro ejem-
plo, la reciprocidad o la transitividad, pueden tener un rol diferente al tratarse de
crear relaciones o de disolverlas.

Nota. No se trata de un inventario exhaustivo. El programa sigue incorporando efectos, pero este
listado permite una descripción básica del modelo.

Con este esquema como referencia3 (Tabla 1), podemos pasar a operar con el pro-
grama. Ya podemos dar nuestros «primeros pasos» con SIENA.

Los primeros pasos con Siena: una sesión de trabajo con el programa

Como hemos mostrado en el apartado anterior, SIENA es un programa que requiere de
un trabajo teórico previo. Por un lado, es necesario conocer los tres componentes del
modelo que corresponden a la estructura del análisis estadístico: la función de utilidad,
la función de velocidad y la función de dotación. Por otro lado, el modelo sustantivo a
contrastar sobre la evolución de la red también debe asentarse en el conocimiento teó-
rico previo del fenómeno bajo estudio.

3. El modelo ha ido evolucionando en las sucesivas versiones del programa. El modelo básico (la función de utilidad)
se ha ampliado con la incorporación de la velocidad y la dotación del cambio de la red. El mismo esquema de trabajo
para analizar la evolución de la red se ha extendido a las co-variables de comportamiento, cuya mutua dependencia
se pretende analizar. Por otro lado, en los primeros trabajos la función de utilidad era denominada «función objetiva»
y la función de dotación era denominada «función de gratificación». Una explicación más detallada de los efectos puede
consultarse en de Federico (2004); y en Snijders et al. (2005).

Talleres de autoformación con programas de análisis de redes sociales Materials 79

Función de utilidad Función de velocidad Función de dotación

Densidad
Reciprocidad
Popularidad
Actividad
Transitividad
Relaciones indirectas
Equilibrio
Popularidad /con una variable
Actividad /con una variable
Similitud /con una variable
Efectos para variables diádicas

Efecto básico de la velocidad
Efectos sobre la velocidad de:
- la actividad,
- la popularidad,
- la reciprocidad,
- los atributos de los actores.

Ruptura de relaciones recípro-
cas
Acceso por relaciones indirec-
tas
Ruptura por variables diádicas
Ruptura por disimilitud

Tabla 1. Efectos del modelo SIENA.
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Pero este documento sólo pretende mostrar de un modo sencillo los pasos habitua-
les en una sesión con SIENA. Así que a continuación mostramos la secuencia de ope-
raciones necesarias para definir y preparar los datos; seleccionar los casos que van a ser
analizados; especificar el modelo a contrastar; e interpretar finalmente los resultados
obtenidos. Esta secuencia aparece destacada en el menú horizontal superior del pro-
grama (véase, por ejemplo, en la Ilustración 1).

1. Definición de los datos.
2. Transformación de los datos.
3. Selección de los casos.
4. Especificación del modelo.
5. Lectura de los resultados.

1. Stocnet se inicia con la definición de los datos que se van a analizar. Se pueden
incorporar matrices de redes de relaciones o de variables diádicas en «Network(s)»
o características de los actores en «Actor attribute file(s)».

Con SIENA generalmente utilizamos la red de contactos entre un conjunto de acto-
res en dos o más momentos diferentes, por lo que el primer paso suele consistir en
añadir («Add») dos o más archivos con dichos datos (Ilustración 2).

Y utilizando las opciones «Edit» o «View» podemos observar las matrices de
datos que vamos a proceder a analizar (Ilustración 3).

También es posible incorporar atributos de los actores que puedan influir en la
evolución de la red, por ejemplo mediante efectos de homofilia (el sexo o la edad),
o mediante efectos de admiración y aspiración (el estatus de los actores). De momento,
para mantener la sencillez de la presentación, no introducimos atributos de los acto-

Ilustración 1. Interface de entrada en StOCNET.

StOCNET > Data >
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res. Caso de desear hacerlo, el procedimiento consiste en añadir («Add») un archivo
con las características de los actores en la sección «Actor attribute file(s)».

Tras cada operación realizada (añadir ficheros, editarlos u operaciones posterio-
res) conviene pinchar en el botón «Apply», que se habrá vuelto activo al realizar
una nueva operación. De esta manera el cambio queda incorporado a la definición
de la sesión de análisis. En todo momento la columna de la izquierda titulada «StOC-
NET Session» permite ver los cambios que se han ido incorporando a la sesión
mediante un «árbol desplegable» organizado según las mismas 5 etapas.

2. El segundo paso da la oportunidad de transformar los datos. En esta fase podemos
recodificar los valores de las variables de nuestro estudio, convertir las matrices en
simétricas o definir los valores perdidos («missing values»). Por ejemplo, si se ha uti-
lizado una escala con cinco valores para definir las relaciones de amistad (v. gr. «des-
conocido», «conocido», «amigo», «buen amigo» y «enemigo») habría que decidir
qué categorías corresponden a la existencia de un lazo de amistad («amigo» y «buen

Ilustración 2.

StOCNET> Data > Add >

Ilustración 3. Las matrices utilizadas en este ejemplo están recogidas en el Apéndice I.

Edit > or View



aJ.L. Molina, A. Quiroga, J. Martí, I. Maya, A. de Federico82 Materials

amigo») y cuáles no («desconocido», «conocido», «enemigo»), ya que SIENA tra-
baja sólo con relaciones definidas de forma dicotómica.

Cuando iniciamos el paso de Transformación de los datos, StOCNET solicita
previamente un título para el archivo donde se van a guardar de modo automático
los resultados de nuestra sesión. En nuestro caso hemos elegido «Sesion1» (Ilustra-
ción 4).

3. El tercer paso de preparación de los datos nos permite seleccionar los casos que
vamos a analizar. Podemos seleccionar a todos los actores, o a un subgrupo de acto-
res, ya sea un rango de ellos, o de acuerdo con una variable o atributo. Generalmente
seleccionamos «todos» los casos en cuestión (Ilustración 5).

4. Finalmente, introducimos las especificaciones del modelo con el que vamos a ana-
lizar los datos. Primero definimos qué datos y variables estarán presentes en nues-
tro análisis (botón de «data specification»). Y a continuación los efectos que quere-
mos analizar con el mismo (botón de «model specification») (Ilustración 6).

Para empezar con un ejemplo sencillo, podemos introducir dos archivos con las

Transformation >

Ilustración 4. Definición y preparación de los datos.
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relaciones entre un pequeño número de actores en dos momentos diferentes. Esta-
rán disponibles aquellos que añadimos en el primer paso. Las matrices a analizar las
pasaremos a la ventana «Digraphs in seq. Order». De momento, vamos a prescindir
de introducir atributos de los actores (Ilustración 7)…

El modelo a analizar lo especificamos a continuación. Señalamos en la columna
«u» (de «utility function») los efectos de red que queremos estudiar (la «e» corres-

Selection > Select All

Ilustración 5. Selección de los datos a utilizar en el análisis.

Model >

Ilustración 6. Especificación del análisis: datos y modelo.
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ponde a la función de dotación endowment function). Para el ejemplo, optamos por
un modelo simple, con los efectos de la densidad, la reciprocidad, el carácter tran-
sitivo y la equivalencia estructural en la evolución de la red (Ilustración 8).

Ya sólo queda ejecutar el modelo que hemos definido. ¡Le damos a «Run»! (Ilus-
tración 9).

Y esperamos pacientemente las tres fases de estimación de SIENA. El tiempo de
estimación del modelo de cambio de una red puede ser bastante largo, dependiendo
del número de actores de la red, el número de efectos nuevos implicados en la esti-
mación y la diferencia entre las redes observadas en distintos momentos del tiempo. 

Dependiendo de la capacidad de computación del ordenador, algunos análisis
pueden llegar a durar varios días.

Data specification > Digraphs in seq. order

Ilustración 7. Selección de los datos de las redes y de los actores.

Model Specification >

Ilustración 8. Selección de los efectos a contrastar en el modelo.
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5. Obtenemos un informe detallado de los resultados. Las potencialidades y límites
del análisis longitudinal de redes hay que ir descubriéndolos poco a poco, pero para
empezar hay dos apartados de los resultados que nos interesan especialmente. 
La convergencia del modelo, y la significación de los parámetros estudiados (Ilus-
tración 10).

Run >

Ilustración 9. El proceso de estimación.

Results >

Ilustración 10. Ventana que permite acceder a los resultados.



La convergencia nos informa de la adecuación general del modelo. La información
que aparece organiza en tres columnas consecutivas los promedios, las desviaciones tipo
y los estadísticos «t». Cuando estos últimos están por debajo de 0.2 podemos conside-
rar adecuado el modelo. Por debajo de 0.1 el resultado es muy satisfactorio. Si tenemos
valores de 0.3 o mayores, conviene repetir el análisis sin cambiar la especificación del
modelo, en general la convergencia mejorará la segunda vez.

Convergence information >

Information for convergence diagnosis.

Averages, standard deviations, and t 
statistics for deviations from targets:

1.      0.056    8.022    0.007

2.      0.444   10.653    0.042

3.      0.026   53.320    0.000

4.     -0.027    1.580   -0.017

Good convergence is indicated by the t-
statistics being close to zero.

En segundo lugar, valoramos la significación de los parámetros del modelo. En cada
caso comprobamos si el valor de estimación (primera columna) es dos o más veces supe-
rior al error estándar (segunda columna), que es más o menos el equivalente a un inter-
valo de confianza del 95%4. En el ejemplo, la reciprocidad y el equilibrio estructural
parecen tener un efecto en la evolución de la red analizada.

@2

Estimation results.

—————————-

Regular end of estimation algorithm.

Total of 1215 iteration steps.

Estimation Results >

@3

Estimates and standard errors 

0. Rate parameter of conditioning variable         1.287993  (   0.426689)

Other parameters:

1. u: density (outdegree)                         -1.106880  (   0.554959)

2. u: reciprocity                                  1.425366  (   0.484723)

3. u: transitivity                                 0.183750  (   0.267330)

4. u: balance                                      4.623074  (   2.239667)

4. Los valores exactos que corresponde a los niveles de significación son respectivamente: si 1.65 <t< 1.96, p < 0.10;
si 1.96 < t < 2.53, p < 0.05; si 2.53 < t < 3.29, p < 0.01; y si t > 3.29, p < 0.001.
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No hay que olvidar que SIENA es un programa de simulación y que el producto
resultante no tiene por qué ser exactamente el mismo en cada aplicación, pese a contar
con las mismas especificaciones del modelo. Un modelo con los mismos parámetros
puede producir distintos resultados en momentos diferentes.

También hay que señalar que los resultados nos informan de la significación de los
efectos (que se controlan mutuamente), pero no es posible comparar las magnitudes o
el tamaño del efecto.

Un ejemplo de aplicación del programa: la evolución de los intercambios
en una lista e correo electrónico

Veamos un sencillo ejemplo de aplicación de SIENA, analizando la evolución de la red
de intercambios de preguntas y respuestas en una lista de correo electrónico.

E-Voluntas es una lista de correo sobre «voluntariado, sociedad civil e intervención
social». Se trata de un canal para compartir experiencias de intervención e investiga-
ción sobre voluntariado. Cuenta con unos 300 subscriptores, de más de 15 países dife-
rentes. Desde su fundación en diciembre de 2002, la participación oscila entre 2 y 14 men-
sajes por semana, aproximadamente.

Analizando quién responde a quién podemos configurar una estructura básica de la
participación en la lista (Borgatti & Molina, 2002; Maya Jariego, 2001). Esto significa
prescindir de aquellos mensajes en la lista de correo en los que no se da un intercambio
persona a persona; haciendo abstracción, además, de que los mensajes en la lista son de
carácter público y ponen en relación (potencialmente) al emisor del mensaje con todos
los subscriptores de la misma. A pesar de estas limitaciones, la red de mensajes y res-
puestas permite representar la estructura de las relaciones entre el grupo de actores más
activos en la comunidad virtual. Por ejemplo, en la secuencia de sociogramas de la
siguiente ilustración (elaborados con Netdraw) podemos comprobar cómo evoluciona la
estructura de intercambios entre los participantes5 (Ilustración 11).

A simple vista, parece que la lista se desarrolla a través de la formación paulatina de
pequeñas agrupaciones, el aumento del número de participantes, la emergencia de líde-
res y la organización progresiva de una estructura social de participación. Sin embargo,
nos interesa conocer de modo más sistemático cuáles son las dinámicas presentes en la
evolución de esta red social. Por eso procedemos recopilando los intercambios en E-
Voluntas, en dos intervalos sucesivos de 16 meses cada uno6. A continuación, analiza-
mos con SIENA los dos momentos observados en la evolución de la red.

Como recomendación general, resulta práctico comenzar con un modelo simple,
incorporando más efectos en sucesivos modelos. Aún no siendo la única forma de pro-
ceder, se puede seguir una aproximación exploratoria en la determinación del modelo.

5. Se trata de grafos dirigidos que representan quién responde a quién en E-Voluntas. Cada gráfico representa sucesivamente
un intervalo más amplio de observación, con un mayor número de mensajes (es decir, cada intervalo incluye al
anterior). Esta estrategia acumulativa sólo ha hemos seguido en la representación gráfica, puesto que SIENA requiere
de dos o más observaciones independientes. El nivel de conexión se refleja con la intensidad del lazo (con un trazo
más grueso). Con fines exploratorios agrupamos los nodos de acuerdo con el algoritmo de Girvan-Newman (en colores
diferentes), reflejando la formación de agrupaciones incipientes.

6. Se trata, de hecho, de los 32 primeros meses de funcionamiento de la lista de correo. El segundo intervalo se empezó
a considerar a partir de la aplicación de la técnica de Netmirror (Borgatti & Molina, 2002; Santolaya & Maya Jariego,
2004). Netmirror consiste en un procedimiento para representar los intercambios entre un grupo de participantes y
proporcionarle feedback sobre sus relaciones. Después de reflejar sus relaciones se espera un aumento de la participación
en la lista y una aceleración de la conformación de una estructura centro-periferia. SIENA podría aplicarse con un
diseño cuasi-experimental, evaluando si las listas de correo donde se ha aplicado Netmirror (V.gr. E-Voluntas)
experimentan cambios que no se observan en los grupos de control (es decir, en otras listas de correo). Sin embargo,
para efectos de este capítulo, analizaremos sólo la evolución de la red de E-Voluntas.
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Por ejemplo, podemos evaluar en un primer paso la incidencia de la densidad y la reci-
procidad en la evolución de la red, para incorporar en un segundo paso la tendencia a aso-
ciarse en función del género. Después de una primera aplicación podemos prescindir de
los efectos no significativos e incorporar otros nuevos. Igual que ocurre con el análisis
de regresión, determinados efectos pueden ser significativos cuando añadimos o elimi-
namos otros.

En general, es recomendable iniciar los análisis con una función de velocidad cons-
tante, y sin efectos de dotación. Por lo que respecta a la función de utilidad, el modelo
debería incluir siempre la densidad (por tratarse de un indicador estructural básico).

En nuestro ejemplo seguiremos la pauta más simple. Consideraremos sólo algunos
efectos endógenos en la evolución de los intercambios en E-Voluntas:

1. En primer lugar, confeccionamos un modelo con los efectos de (a) la densidad y (b)
la reciprocidad.

2. A continuación, y en función de los resultados, comprobaremos la existencia de (c)
una lógica transitiva en la evolución de la red («los amigos de mis amigos se con-
vierten en mis amigos»).

Ilustración 11. Secuencia de sociogramas mensajes-respuestas en la lista de correo E-Voluntas.
(La serie se ordena de izquierda a derecha y de arriba abajo).



Diagnóstico de convergencia Resultados de estimación
finales

Efecto (n = 113) AES S.D. t AES S.E.

Función de utilidad

Densidad –1.132 11.592 –0.098 –2.782 0.0771
Reciprocidad –0.800 7.984 –0.100 2.022 0.1138

n = número de actores; AES = tamaño del efecto promedio estimado; SE = error estándar; SD = desviación
tipo; t = estadístico de significación, t de student.

Tabla 2. Resultados del Modelo 1.

Como vemos en la tabla 2, el modelo cuenta con un nivel de significación adecuado,
con valores de t por debajo de 0.1 en el diagnóstico de convergencia. Además, los valo-
res de estimación de los dos efectos incluidos en el modelo resultan significativos, como
podemos observar en los resultados de estimación finales. Tanto la densidad como la
reciprocidad parecen tener un efecto en la evolución de la red.

En segundo lugar, para comprobar si la formación de tripletes transitivos afecta al
desarrollo de la red, incorporamos la transitividad en el modelo de la tabla 3. En este
caso fue necesario someter a estimación en dos ocasiones el modelo para lograr resul-
tados válidos. Como podemos observar, pese a obtener un tamaño del efecto relativamente
bajo, la transitividad mostró también un resultado significativo en la evolución de la red.

Debemos recordar que los efectos de las distintas variables se controlan recíproca-
mente, por lo que el Modelo 2 puede tomarse como evidencia de que la reciprocidad y
la transitividad están presentes simultáneamente en la evolución de los intercambios en
la lista de correo.

Teniendo en cuenta las limitaciones de los datos disponibles, se trata –en nuestra
opinión– de una conclusión bastante reveladora de los patrones de cambio en la red ana-
lizada7.

Diagnóstico de convergencia Resultados de estimación
finales

Efecto (n = 113) AES S.D. t AES S.E.

Función de utilidad

Densidad –1.456 19.453 –0.075 –2.859 0.086
Reciprocidad –1.744 17.127 –0.102 1.687 0.171
Transitividad –5.486 83.721 –0.066 0.546 0.096

n = número de actores; AES = tamaño del efecto promedio estimado; SE = error estándar; SD = desviación
tipo; t = estadístico de significación, t de student.

Tabla 3. Resultados del Modelo 2.

7. Para la mayor claridad del ejemplo, hemos prescindido de los cambios en la composición de la lista de correo que se
producen entre ambas observaciones. Por otro lado, la incorporación de una tercera observación –controlando los
cambios de composición en la lista- puede mostrar más claramente el proceso de evolución de la red. Las dos matrices
para trabajar este ejemplo están disponibles en el fichero comprimido: <http://revista-redes.rediris.es/siena_ejemplo.zip>. 

Talleres de autoformación con programas de análisis de redes sociales Materials 89



aJ.L. Molina, A. Quiroga, J. Martí, I. Maya, A. de Federico90 Materials

Veamos ahora gráficamente los cambios entre observaciones. Este paso, aunque no
corresponde al programa SIENA nos puede servir para interpretar los resultados (Bran-
des, Kenis & Raab, 2006), y en este capítulo tiene una función ilustrativa.

En los primeros 16 meses de funcionamiento de la lista se constituye una red muy
centralizada. La dinamización de la comunidad virtual depende de unos pocos partici-
pantes. Por ejemplo, el administrador de la lista es el autor del 32 por ciento de los men-
sajes. Aunque se intuyen algunas agrupaciones, la red parece muy dispersa, con cierta
dependencia respecto a tres nodos vertebradores. De hecho, si retiramos los tres nodos
con mayor centralidad, la red se disgregaría en ocho componentes separados (Santolaya
& Maya Jariego, 2004). Se trata en general de un grupo todavía poco estructurado (Ilus-
tración 12).

En el seguimiento, durante los 16 meses siguientes a la primera observación, se
obtiene una red más compleja y diversificada. Como observamos en la ilustración 13,
se trata de una configuración más densa, pese a contar con mayor número de actores. Ade-
más, es posible reconocer algunas agrupaciones incipientes, y hay al menos 7 subscri-
tores destacados por su nivel de participación. Es, en general, un grupo de discusión más
activo y organizado que el que observamos en el primer intervalo (Ilustración 13).

La información descriptiva apoya estas interpretaciones. Como vemos en la tabla 4,
la segunda observación corresponde a una red ligeramente más densa, con un mayor
número de tripletes transitivos, y donde ha aumentado la participación, tanto en número
de actores como en número de mensajes promedio. Además, entre ambas observaciones
parece haber aumentado el número de actores que ocupan el núcleo de los intercambios
pregunta-respuesta.

Ilustración 12. E-Voluntas en Tiempo 1.
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La información descriptiva permite comprobar que a lo largo del tiempo se produce
un aumento en la participación en la lista de correo. Así lo reflejan los indicadores de den-
sidad y de centralidad promedio.

Sin embargo, el análisis longitudinal con SIENA nos ha servido para poner de mani-
fiesto que la reciprocidad y la transitividad son dos de los factores endógenos que están
presentes en la evolución de la red de intercambios. Esta conclusión difícilmente habrí-
amos podido alcanzarla sin la metodología para el análisis longitudinal que proporciona
SIENA.

E-Voluntas T1 E-Voluntas T2

Densidad de la red 0.009 0.011
Centralidad de grado promedio 0.991 1.286
(average degree)
Densidad del subconjunto de actores 1,009 1,148
participantes en cada observación
Reciprocidad híbrida 0,18 0,22
Transitividad 74 83
Centro / Periferia cualitativa isidromj, pnavajo, isidromj, pnavajo,

fransantolaya, fransantayola,
delariva, anna, delariva, mvillareal,
aeciruj holgado, felixmata,

cvuadinet

Los dos primeros indicadores fueron calculados con SIENA para el total de la red (n = 113), mientras que
los tres últimos indicadores fueron calculados con UCINET (Borgatti, Everett & Freeman, 2002), con el sub-
conjunto de actores participantes en cada observación (n = 53; y n = 81, respectivamente).

Tabla 4. Estadísticos de la red de relaciones en tiempo 1 y en tiempo 2.

Ilustración 13. E-Voluntas en Tiempo 2.
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Los datos de nuestro ejemplo parecen apuntar a que la formación de una comunidad
virtual se asienta en la conformación progresiva de una estructura centro-periferia en
torno a un pequeño número de actores clave. Dicho núcleo se expande progresivamente,
aumentando la densidad de la red mediante el establecimiento de relaciones transitivas
y recíprocas. Pero esto es sólo un apunte para futuras investigaciones.
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Apéndice I. Matrices utilizadas en el apartado Los primeros pasos con Siena
(Obsérvese el espacio en blanco antes de cada fila).

Matriz_tiempo_1.dat
0 0 0 0 0 0 1 0 0 0 0 0 0 0 0 1 0 0 0 0 0 0 0

0 0 0 0 0 1 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0

0 0 0 0 1 0 0 0 0 1 0 0 0 0 0 0 0 0 0 0 0 0 0

0 0 1 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 1

0 0 1 0 0 0 0 0 0 1 0 0 0 0 0 0 0 0 0 0 0 0 0

0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 1 0 0 0 0 0 0

1 0 0 0 0 0 0 0 0 0 0 0 0 0 0 1 0 0 0 0 0 0 0

1 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 1 0 0 0 0 0

0 0 0 0 0 0 0 0 0 0 0 0 0 0 1 0 0 0 1 0 0 0 1

0 0 1 0 1 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0

0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0

0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0

0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0

0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0

0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 1 0 0 0 0 0 0 1

0 0 0 0 0 0 1 0 0 0 0 0 0 0 0 0 1 0 0 0 0 0 0

0 0 0 0 0 0 0 0 0 0 0 0 1 0 1 0 0 0 0 0 0 0 0

1 0 0 0 0 0 0 1 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0

0 0 0 0 0 0 0 0 1 0 0 0 0 0 0 0 0 0 0 0 0 0 1

0 0 0 0 0 0 0 0 0 0 1 0 0 0 0 0 0 0 0 0 0 0 0

0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0

0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0

0 0 0 0 0 0 0 0 1 0 0 0 0 0 1 0 0 0 1 0 0 0 0

Matriz_tiempo_2.dat
0 0 0 0 0 0 1 1 0 0 0 1 0 0 0 0 1 1 0 0 0 0 0

0 0 0 0 0 0 0 0 0 0 0 0 0 1 0 1 0 0 0 0 0 0 0

0 0 0 0 0 0 0 0 0 0 1 0 0 0 0 0 0 0 0 0 0 0 0

0 0 0 0 0 0 0 0 1 1 1 0 0 0 1 0 0 0 1 0 0 0 1

0 0 1 0 0 0 0 0 1 1 1 0 0 0 0 0 0 0 0 0 0 0 1

0 0 0 0 0 0 0 0 0 0 0 1 0 0 0 0 0 0 0 0 0 0 0

0 0 0 0 0 0 0 1 0 0 0 1 1 0 0 0 0 1 0 0 1 1 0

0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 1 0 0 0 0 0

0 0 0 1 0 0 0 0 0 1 1 0 0 0 0 0 0 0 0 0 0 0 1

0 0 0 1 0 0 0 0 1 0 0 0 0 0 0 0 0 0 0 0 0 0 1

0 0 1 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 1 1 0 0 0

1 0 0 0 0 1 0 0 0 0 0 0 1 0 0 0 0 0 0 0 1 1 0

0 0 0 0 0 0 1 0 0 0 0 1 0 0 0 0 0 0 0 0 1 1 0

0 1 0 0 0 0 0 0 0 0 0 0 0 0 0 1 0 0 0 0 0 0 0

0 0 1 1 0 0 0 0 0 1 1 0 0 0 0 0 0 0 0 1 0 0 0

0 1 0 0 0 0 0 0 0 0 0 0 0 1 0 0 0 0 0 0 0 0 0

1 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0

0 0 0 0 0 0 0 1 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0

0 0 0 0 0 0 0 0 0 0 1 0 0 0 0 0 0 0 0 0 0 0 0

0 0 1 0 0 0 0 0 0 0 1 0 0 0 0 0 0 0 1 0 0 0 0

0 0 0 0 0 0 0 0 0 0 0 1 0 0 0 0 0 0 0 0 0 1 0

0 0 0 0 0 0 1 0 0 0 0 1 0 0 0 0 0 0 0 0 1 0 0

0 0 0 1 0 0 0 0 1 0 0 0 0 0 0 0 0 0 0 1 0 0 0





En muchas aplicaciones del análisis de redes resulta más práctico introducir los datos rela-
cionales de forma gráfica, mediante un sociograma, en lugar de utilizar una matriz de
datos o el formato DL. Además, en muchos casos deseamos realizar un análisis de los
datos que sea eminentemente visual. visone es uno de los programa existentes que explota
a fondo estas posibilidades, y en este capítulo nos ocuparemos de él. Y lo haremos con
una aplicación del ARS que se adecua especialmente a estos casos: el análisis reticular
de textos.

El análisis reticular de textos

Bajo este nombre podemos englobar un conjunto muy amplio y diverso de procedimien-
tos que pretenden representar los discursos como una red de significados. La idea es
bien sencilla: las palabras, acciones, proposiciones …son nodos de un entramado lingüís-
tico que las relaciona. Y esta estructura conceptual, discursiva o narrativa puede ser estu-
diada mediante el análisis de redes sociales, mostrando esquemas cognitivos.1

En particular, el procedimiento con el que se ejemplificará esta aplicación será el
análisis reticular del discurso basado en la teoría de la argumentación en la lengua. Esta
teoría, desarrollada por Anscombre y Ducrot (1983), se centra en una relación discursiva
llamada topos. Para estos autores, un topos es un vínculo entre dos proposiciones inter-
dependientes, P y Q, que puede ser vista como una estructura argumento-conclusión que
da soporte a un enunciado (por ejemplo, si alguien dice «he encontrado trabajo porque
tenía buenos contactos», desde la teoría de la argumentación se diría que este argumento
es comprensible no tanto por la presencia de la preposición «porque», sino debido al
hecho de que existe un topos, una creencia socialmente compartida, que relaciona dos
hechos: el de tener buenos contactos y el de insertarse laboralmente). Con algunas reo-
rientaciones, esta herramienta lingüística se ha aplicado satisfactoriamente al análisis
sociológico del discurso (puede encontrarse un mayor desarrollo de este método en
Martí, 2000).

El pequeño fragmento de texto con el que trabajaremos en este capítulo corresponde
a una entrevista realizada a una cajera de hipermercado de 26 años, a la que se pedía
que trazara las grandes etapas de su vida (Martí 2000: 160):

Hombre, yo cuando empecé a trabajar, pues con más libertad porque en mi casa, siem-
pre era del instituto a mi casa, no. No tenía amigos, no salía apenas. Y te cambia mucho
la vida porque ya salía, disponía de mi dinero que cambia. Luego enseguida ya..., empecé
a salir con mi marido. Ya empecé a salir y me cambió la vida en ese año, a partir de los
dieciocho años, para acá, sí, me ha cambiado la vida, es lo que más. Pero al principio era
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1. Para más información sobre el análisis reticular de textos consultar Lozares y otros (2003).



una cría, no tengo muchos recuerdos de..., hombre, la etapa del instituto que tampoco fue
muy buena, porque no tenía amigos y no, lo pasé... Es que yo no soy muy comunicativa
y lo pasé mal. Luego aquí ya me fui abriendo con la gente, también estaba de cara al
público, te abres más, te haces más sociable... 

La interpretación de este texto nos lleva a la representación gráfica que nos mues-
tra la ilustración 1 (en tanto que se trata de un proceso interpretativo, esta no es la única
representación posible).

Más allá de la secuencialidad de la narración, la observación de la estructura dis-
cursiva nos permite mostrar su forma a simple vista: este discurso parte del mundo labo-
ral (gracias a éste se obtiene más independencia y se aprende a relacionarse con otros),
fluye por el ocio (se sale, se conoce gente) y desemboca en el ámbito doméstico (una
empieza a salir por ahí... y termina casándose). En textos más amplios, en los que estruc-
turas discursivas más complejas están entrelazadas a lo largo de varias argumentacio-
nes, la construcción de un sociograma en el que unas relaciones se solapan con otras y
se muestran globalmente permite mostrar y analizar una red cognitiva global.

El programa Visone

visone2 es un programa pensado especialmente para la representación de sociogramas y
su análisis de forma predominantemente visual. Aunque no tiene las potencialidades
analíticas de otros programas de ARS, sus interesantes visualizaciones hacen de él una
herramienta ideal para un estudio exploratorio de datos relacionales. Además de las ruti-
nas propias de análisis y representación, visone puede exportar los datos a otros progra-
mas para realizar análisis más detallados, como Ucinet.

2. Los orígenes de este programa, ideado por Ulrik Brandes y Dorothea Wagner, se encuentran en la Universidad de
Konstanz. Está disponible gratuitamente para fines académicos y de investigación en la dirección www.visone.info.
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Ilustración 1. Red discursiva.



Panorámica general del programa

En la versión con la que trabajaremos aquí (2.0.2, plenamente funcional), el programa
consta de un archivo de ejecución en Java que no requiere instalación, aunque previa-
mente hay que tener instalado este entorno (JRE 1.5).3

Al ejecutarlo por primera vez se creará una carpeta en la que el programa guardará
los arhivos de configuración, y se abrirá la pantalla principal del programa, en la que,
además de las barras de menús, botones y estatus, podemos distinguir tres áreas:

— Área A: Inicialmente en blanco, es la zona principal de entrada de datos (siempre de
forma gráfica) y visualización.

— Área B: Permite visualizar globalmente el sociograma y desplazarlo por la pantalla. 
— Área C: Contiene los comandos de análisis y visualización que constituyen el cora-

zón del programa. 

Los menús del programa son muy intuitivos, por lo que no los explicaremos en deta-
lle. En File se encuentran las opciones de gestión de archivos (crear, abrir, guardar,
exportar y opciones generales de configuración -por ahora, los únicos idiomas disponi-
bles son el inglés y el alemán); los menús de Nodes y Links nos permiten seleccionar y
cambiar las opciones de visualización de nodos y vínculos, mientras que Layout y View
permiten elegir entre distintas formas de visualización del sociograma en su conjunto;
el menú de ayuda se encuentra, por ahora, sin desarrollar (Ilustración 2). 

La primera vez que cerremos visone, éste creará automáticamente una subcarpeta
en la ruta en la que se encuentra el programa, en la que va a guardar automáticamente
los archivos de configuración y preferencias.

3. Descargaremos el archivo del programa desde la página principal de Visone (www.visone.info), lo guardaremos en
la carpeta que deseeemos y lo ejecutaremos haciendo doble clic sobre el icono. Si el sistema no reconoce el programa,
deberemos instalar el entorno Java
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Ilustración 2. Pantalla principal de visone.
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Los sociogramas que creemos deberemos guardarlos manualmente desde el menú
File>Save as. Los archivos de visone (con formato y extensión .graphml) guardan la
información correspondiente a los nodos y vínculos, su formato y su ubicación en el
plano. Para abrir un archivo existente deberemos hacerlo desde el mismo programa
(menú File>Open).

Cómo crear sociogramas y modificar el aspecto de nodos y vínculos

Las funciones del ratón son distintas en cada uno de lo que visone llama «Modes», por
lo que es recomendable familiarizarse con los mismos para poder moverse mejor por el
programa. Los cuatro modos de visone (Analysis, Insertion, Navigation y Zoom) se
corresponden, respectivamente, con los cuatro últimos iconos de la barra de botones, y
también podemos acceder a ellos desde el menú View>Mode.

Por defecto, el programa se inicia en el modo Insertion, el que debemos usar para
crear nodos y vínculos. Estas funciones se realizan en la ventana principal (área A) con
el botón izquierdo del ratón:

— Crear un nodo: basta con hacer clic en cualquier lugar de la pantalla y aparecerá un
nuevo nodo.

— Crear un vínculo entre dos nodos: Señalar un nodo con el botón izquierdo. Al sol-
tar el botón del ratón, el nodo aparecerá sombreado; desplazamos el ratón hasta el
nodo de destino y hacemos clic encima (si se hace en un lugar en blanco de la pan-
talla, se creará un nuevo nodo vinculado al anterior).

Podemos aumentar o disminuir el tamaño del sociograma pulsando en la lupa que
tenemos en la barra de botones, y activando el modo Zoom podemos focalizar la visua-
lización arrastrando el ratón por un área concreta del sociograma (para volver a visua-
lizar todo el sociograma, menú View/Zomm 100% o, alternativamente, clic en el botón
correspondiente o pulsar <enter> en el teclado). También podemos arrastrar nodos con-
cretos y moverlos por la pantalla si activamos el modo Analysis.

Pero... ¿y cuando llega el momento en el que tenemos una infinidad de nodos y vín-
culos que se entrecruzan y no vemos nada? Ningún problema: basta con acudir al menú
Layout y escoger uno de los algoritmos de visualización.

En cualquier momento (excepto estando en el modo Zoom) podemos acceder a dis-
tintas opciones sobre los nodos y los vínculos haciendo clic con el botón derecho (menú
contextual). Mediante la opción Edit label podemos cambiar la etiqueta del nodo (que
visone introduce por defecto) o añadir, si lo deseamos, una etiqueta al vínculo. Pulsando
Properties accederemos a un cuadro de diálogo en el que podemos configurar caracte-
rísticas y apariencias de cada uno de los elementos; en el caso de los vínculos, varias opcio-
nes addicionales nos permiten cambiar la direccionalidad y valor de la relación (Ilustra-
ción 3).

Claro que, para empezar, lo mejor es configurar globalmente el programa para que
los nodos y los vínculos aparezcan, por defecto, con la configuración que más nos inte-
rese. Lo veremos en el siguiente apartado.
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Creación de una red discursiva con Visone

Configuración general

Para representar el ejemplo propuesto de red discursiva, primero deberemos cambiar el
formato de los nodos para que las etiquetas de texto se puedan leer correctamente. Desde
el menú Nodes>Properties, vamos a la pestaña Label y situamos las etiquetas de texto
fuera de la figura (en South, por ejemplo). Pulsamos Create template para activar los
cambios y Close para salir del cuadro de diálogo.Todos los nodos que generemos ahora
tendrán este formato por defecto (y, con la misma lógica, podemos cambiar la forma, el
color, etc.). Para este ejemplo no es necesario modificar las opciones por defecto de los
vínculos, aunque el procedimiento es análogo (menú: Links>Properties). Todos estos
cambios los podemos ir gestionando desde la pestaña Templates de la ventana principal
(área C), en la que podemos guardar distintas configuraciones (plantillas) que el pro-
grama registra en los archivos de configuración para que se mantengan la próxima vez
que entremos (Ilustración 4).

Ilustración 3. Menús contextuales de ndos y vínculos.

Ilustración 4. Configuración por defecto de los nodos (Nodes>Properties).
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Dibujando nodos y vínculos

Una vez definido el formato de los nodos, sólo nos queda dibujarlos en pantalla y vin-
cularlos entre ellos (recordemos que para introducir nodos y vínculos debemos estar en
el modo Insertion; en caso de no ser así, deberemos activarlo). Cada clic que hagamos
en la pantalla nos creará un nuevo nodo al que visone atribuye un número; deberemos
cambiar este número por una etiqueta que corresponda al significado que va a reflejar;
basta con señalar el nodo en cuestión con el botón derecho, ir a la opción Edit label y
cambiarla.

Introducimos todos los nodos del ejemplo y las relaciones entre los mismos. Por
defecto, visone está configurado para crear relaciones dirigidas y no valoradas. Si alguna
de estas relaciones fuera bidireccional, basta con editar la configuración del vínculo en
cuestión (Properties en el menú contextual, señalando el vínculo con el botón derecho).
Si, por defecto, queremos que todos los vínculos que creemos sean no dirigidos, bastará
con indicárselo así en el menú Links>Properties>General/Direction/Undirected.

El grafo nos debe quedar parecido al que muestra la ilustración 5.

Visualización y análisis de la red

Análisis básicos

El menú Layout nos ofrece distintas opciones de visualización, pero en visone destacan
sobretodo las rutinas de análisis/visualización contenidas en la pestaña Controls, a la
izquierda de la pantalla.

Veamos un ejemplo. En primer lugar, analizaremos el grado de entrada (Indegree)
marcando la opción correspondiente en Algorithm, y llamaremos «Entrada» a los resul-
tados, escribiéndolo en el espacio correspondiente (Result Attribute). Si hacemos clic
en Analyze! no pasa, aparentemente, nada; sin embargo, vayamos ahora a la pestaña
Value Grups, e indiquemos al programa que nos proyecte los resultados (Name: Entrada).
Observaremos que en la columna «Value» aparecen los distintos valores que toma el
Indegree en el sociograma analizado, y en la columna Count, el número de nodos que
tienen ese valor. Todavía más: si señalamos un determinado valor con puntero del ratón
y hacemos clic, nos señala en la pantalla de qué nodos se trata (Ilustración 6).

Ilustración 5. Sociograma.
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Seguidamente, indicaremos al programa que queremos que represente este dato
variando el ancho de los nodos. Para hacerlo, volvemos a la pestaña Controls y, en el campo
Visualization, marcamos la opción Property/Node With y especificamos que lo que que-
remos representar son los resultados anteriores: Node Value/Entrada. Pulsamos en Visua-
lize! y observaremos los cambios en la pantalla. 

Podemos repetir el mismo procedimiento para el grado de salida: en la pestaña Con-
trols, marcamos Algorithm/Outdegree y escribimos «Salida» en Result Attribute, y hace-
mos clic en Analyize! Seguidamente, representamos el grado de salida mediante la altura
del nodo: Property/Node Height y Node Value/Salida. Clic en Visualize! y nos tiene que
quedar un grafo parecido a este: a mayor grado nodal de entrada (indegree), la figura es
más ancha; a mayor grado nodal de salida (outdegree), la figura es más alta (Ilustra-
ción 7). 

Ilustración 6. Análisis gráfico desde la pestaña Value Groups.

Ilustración 7. Representación del grado nodal en la forma de los nodos.
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Otro indicador que nos puede ofrecer información sobre la red textual y que nos per-
mitirá explorar otras potencialidades del programa es la centralidad por intermediación
(betweenness). Éste nos indica qué nodos son más estratégicos, al situarse como puente
entre unos y otros. Marcamos, en la pestaña Controls, Algorithm/Betweenness, y en
Result Attribute escribiremos «Intermediación». Pulsamos Analyze! y nos vamos a la
pestaña Value Groups para visualizar los nodos con mayor intermediación (situamos el
ratón encima del valor 0,2609 y hacemos clic con el botón izquierdo). Destacaremos
estos nodos en rojo: como los tenemos seleccionados, basta con ir al menú Nodes/Pro-
perties y cambiar el color. Pulsando Apply veremos como los cambios se reflejan en el
grafo (Ilustración 8).

Observamos que, en este ejemplo, estos nodos corresponden al mundo relacional
(«tener amistades» y «tener pareja», ambos con un valor de 0,2609), que se situaría aquí
como mediador entre la actividad laboral y el ámbito doméstico. Y supongamos que este
«estar en medio» que nos señala la intermediación queremos expresarlo de forma grá-
fica. Entonces, puede ser interesante realitzar una representación radial del índice, en el
que cuanta más intermediación tenga un nodo, más «en medio» de la pantalla se sitúe.
Si queremos representar la intermediación de este modo, basta con señalar, en el apar-
tado Visualization de la pestaña Controls, los comandos Property: Radius y Node Value:
Intermediación. Obtendremos un grafo parecido al que muestra la ilustración 9.

visone 1.1 nos ofrece un índice de centralidad muy interesante para redes textuales,
que todavía no ha sido incorporado a la versión 2.0.2, pero que lo será próximamente:
el PageRank. PageRank es un indicador introducido y utilizado por la empresa Google
(Brin y Page, 1998) para indexar la importancia de las páginas web. Explicado de forma
intuitiva: se trata de atribuir puntos a aquellas páginas (nodos) que son enlazadas por
otras (cuanto más enlaces lleven a una página, más importante será ésta); a su vez, estos
puntos son ponderados por la importancia que tienen las páginas que contienen los enla-
ces. En una red de significados, el PageRank puede ser interpretado como un indicador
de accesibilidad de los nodos, es decir, del grado en que un significado es accedido por
el resto; los valores altos de PageRank nos suelen indicar los «puntos de llegada» más
centrales de los discursos. En cambio, los valores bajos nos dan buenas pistas de cuales
son los «principios motores» de los discursos, aquellas acciones o significados que desen-
cadenan el resto. Veamos como se distribuyen estos valores en el ejemplo (aunque el

Ilustración 8. Representación de alta intermediación en el color de los nodos.
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análisis ha sido realizado con visone 1.1, este tipo de representación puede obtenerse
con otros índices en la versión 2.0 indicando Property/Layer en el campo Visualization)
(Ilustración 10).

Vemos como los nodos con valor de PageRank más altos (los más accesibles) son
TENER PAREJA y CASARSE: se sitúan aquí como nodos finalistas, puntos de llegada
del discurso (la propia representación gráfica muestra como parece que todo el discurso
«fluye» hacia allí). Los nodos con un PageRank más bajo son los referidos a la activi-
dad laboral, y muestran como ésta es el motor o generador del resto, porque es la que
acaba «enlazando» con la boda.

Ilustración 9. Representación radial de la intermediación.

Ilustración 10. Representación por capas de PageRank.
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Más posibilidades

Además de los anteriores, el programa permite el cálculo/visualización de otros índices
de centralidad. Todos ellos se encuentran definidos en un artículo de los autores dispo-
nible en red (Brandes y Wagner, 2003). La nueva versión de visone incorpora también
cálculos de agrupación y análisis de subgrupos que no desarrollaremos aquí, pero que
pueden aplicarse siguiendo las mismas pautas que se han introducido.

Por otro lado, en muchos casos el interés del análisis es poder comparar distintos
textos o discursos. Utilizando el mismo método, los grafos adjuntos muestran la estruc-
tura discursiva de dos editoriales de periódicos españoles, El Mundo y El Periódico de
Catalunya, sobre el hundimiento de un túnel de metro en Barcelona y el posterior con-
flicto político que se generó por acusaciones de corrupción entre grupos políticos (la lla-
mada «crisis del 3%»). Se observa cómo para El Mundo, de línea conservadora, la noti-
cia es la crisis política desencadenada en el gobierno de izquierdas, y cómo lo que origina
esa crisis son los dos principales fantasmas de este periódico en Cataluña: el gobierno
de Maragall (responsable de aprobar las obras que dieron lugar al hundimiento) y la pre-
sencia del partido independentista ERC en el mismo (que conlleva nerviosismo y mala
gestión de la crisis). El tratamiento de los mismos hechos es bien distinto en El Perió-
dico de Catalunya, defensor de las tesis gubernamentales: la noticia principal es la salida
a la luz del cobro de comisiones ilegales por parte del gobierno anterior (la crisis polí-
tica es sólo un elemento derivado de esta acusación). Para esta editorial los cobros son,
en última instancia, los causantes de la reducción de costes de obra que ha provocado el
hundimiento; con lo que se justifica que, amparado en la inmunidad parlamentaria, el
Gobierno catalán haya hecho estas acusaciones a la oposición (Ilustración 11).

* Editoriales del 25/02/2005 (www.elmundo.es) y 27/2/2005 (www.elperiodico.com).

Ilustración 11. Comparación de dos editoriales por Degree y PageRank.

El Mundo* El Periódico de Catalunya*
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El método expuesto aquí, basado en la identificación de vínculos tópicos, es sólo
uno de los muchos posibles. Serán los objetivos del análisis y los supuestos metodoló-
gicos los que lleven a definir el procedimiento de análisis reticular de textos más perti-
nente. La siguiente ilustración muestra un mapa conceptual de visone realizado desde el
método del Centering Resonance Analysis (Corman y otros, 2002), basado en la proxi-
midad de palabras en el texto. Se trata de un análisis de noticias de Reuters durante el
primer día de los atentados del 11-S en Nueva York, basado en un grafo inicial de más
de 2400 nodos de los que se extrajeron los 42 más centrales (Batagelj y otros, 2002;
citado en Brandes y Wagner, 2003) (Ilustración 12).

Salidas y exportación de resultados

Las visualizaciones de visone se pueden exportar sin ningún problema a cualquier otro
programa. Además de la opción más «artesanal» de copiar el gráfico con cualquier cap-
turador de pantallas y guardarlo en el formato  que más nos convenga (BMP, JPG...),
podemos exportar la imagen a formatos de alta calidad como Postscript (PS) o Scala-
ble Vector Graphics (SVG), aunque éste último puede presentar en ocasiones proble-
mas de conversión. Estas opciones se encuentran en el menú File>Export.

También nos puede interesar exportar los resultados a otros programas de análisis de
redes para realizar análisis más detallados. Veremos un ejemplo de exportación hacia
Ucinet. Para ello, la opción más recomendable es transformar el formato de visone a DL
para abrirlo con Ucinet y, desde ahí, convertirlo a archivos ##D / ##H. Deberemos hacerlo
en dos pasos:

Ilustración 12. Análisis de las noticias de Reuters en los atentados del 11-S*.
* Extraído de Brandes y Wagner (2003), pág. 17.
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1. Exportación de visone a DL. Después de haber guardado la versión definitiva del
archivo en visone, guardarlo en formato DL desde el menú File>Export y, en
Files of type, escoger Ucinet DL Files.

2. Importación de formato DL a Ucinet (.##d). Ejecutar Ucinet y, desde la pantalla
principal, acceder al menú Data>Import>DL. En el cuadro de diálogo que nos
aparece, deberemos explorar e introducir el nombre de archivo DL. Automática-
mente, Ucinet atribuirá el mismo nombre al archivo de salida, pero esta vez en
el formato propio del programa (Ilustración 13).

La matriz está lista para ser analizada con Ucinet (Ilustración 14).

Ilustración 13. Importación de datos desde Ucinet.

Ilustración 14. Output del fichero de datos importado.
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